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1Introduction
1.1  KnowledgeWorks
KnowledgeWorksTM is a LispWorks toolkit for building knowledge based
systems. It is a multi-paradigm programming environment which allows
developers to express problems in terms of objects, rules, and procedures. The
following sections provide an historical perspective and an overview of the
system.

1.2  Background
Broadly speaking, there have been two generations of commercial knowledge
based system (KBS) shells. The first generation of KBS shells were built on top
of symbolic programming languages such as Lisp. These shells exhibited a
high degree of flexibility and functionality as a result, but suffered because of
their lack of standardization, poor performance, and inability to communicate
with other applications. The second generation of KBS shells were generally
written in C to attack the latter two weaknesses of Lisp-based shells. However
these C-based shells are inevitably less flexible, and exacerbate the standard-
ization issue. Although written in a C (a standard language),  each  C-based
shell  must  re-invent  a  range of  features already provided as standard in
every  Common Lisp implementation, including the object-system  and even
elementary structures like lists.
1
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KnowledgeWorks addresses all of these issues by providing a high perfor-
mance rule-based system for LispWorks. The latter is a full and efficient
Common Lisp implementation including the Common Lisp Object System
(CLOS), and foreign function interfaces to languages such as C, C++, and
FORTRAN. Hence KnowledgeWorks constitutes a tightly integrated multi-
paradigm programming environment, allowing all the most powerful fea-
tures of rule-based, object-oriented and procedural approaches to be com-
bined without abandoning accepted standards.

1.3  Technical Overview
KnowledgeWorks includes:

• High performance inferencing mechanisms:

forward chaining (OPS compatible)

backward chaining (Prolog compatible)

• A powerful standard object system (CLOS)

• A flexible standard procedural language (Common Lisp)

• Metaprotocols for extending the object and rule systems (MOP & MRP
— see below)

• A full set of graphical tools for developing and debugging knowledge
bases

• Complete compatibility with other LispWorks toolkits (for example,
ClassWorksTM and the Authoring BookTM)

• Integration within larger applications, possibly following a completely
different paradigm



1.3 Technical Overview
KnowledgeWorks rules perform pattern-matching directly over the object base
(KnowledgeWorks CLOS objects and KnowledgeWorks structures). Forward
chaining rules use this pattern-matching to perform  actions, while backward
chaining rules use it to deduce goals. The actions of forward chaining rules
can call backward chaining rules, and the backward chaining inference engine
may also invoke the forward chainer. Forward chaining rules may be grouped
to increase the modularity of the rulebase and to introduce a mechanism for
procedural control by explicit invocation of rule groups.

Rule Base

Backward Chaining
Forward Chaining

LispWorks

KnowledgeWorks

Object Base

Structures

CLOS instances

M
R

P
M

O
P

Database Interface
(Dynamic SQL)

Foreign Function

C FortranC++

Interface
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KnowledgeWorks CLOS objects are conventional CLOS objects with the
simple addition of a mixin class providing KnowledgeWorks functionality,
and they can be used outside the rulebase as ordinary CLOS objects. Any
existing CLOS code may simply be reused and augmented with rules by
adding the mixin to chosen classes.

LispWorks CLOS includes an implementation of the Meta Object Protocol
(MOP) which allows the object system to be extended and customized in a
standard way. In the same spirit of self-reflection, KnowledgeWorks rule-
based system can be extended and customized using a Meta Rule Protocol
(MRP) which allows meta-interpreters to be defined for rules. Together these
protocols mean that KnowledgeWorks defines a region rather than a point in
space of KBS shells, and ensure that developers are not constrained by the
default behaviour of the system.

KnowledgeWorks has a comprehensive programming environment that
enables rapid development and debugging of rulebases. Tools are provided
that enable the interactive examination of classes and objects. Graphical
debugging windows allow forward and backward chaining rules to be single-
stepped and monitored. The full LispWorks programming environment and
tools are also available, for example, the editor which allows rules to be
defined and redefined incrementally and dynamically (see the Editor User
Guide).

1.4  Notation Conventions
Syntax will be presented in BNF. Any other non-standard notation will be
explained as used.

::= introduces a definition

<..> token, or non-terminal symbol

[..] delimits optional items

* 0 or more repetitions of the previous token

+ 1 or more repetitions of the previous token

| separates alternatives
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2Tutorial
The tutorial is a simple example based on an animal guessing game. In this
game the user thinks of an animal and the program asks yes/no questions.
Eventually the program mentions an explicit animal and asks whether it is
correct. If so, the game ends. If it is not correct it will ask what the animal was
and ask for a question to distinguish it from its last guess. This is a trivial
example of a learning program. The tutorial assumes a certain familiarity with
Lisp, LispWorks and the Common Lisp Object System (CLOS).

All examples in this chapter assume that you are typing in expressions in a
package that use s the KW package, for instance, KW-USER.

2.1  Getting Started
To run the tutorial, start KnowledgeWorks as described in the LispWorks
Installation and Release Notes. The KnowledgeWorks Podium will appear.
5
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Figure 2.1 KnowledgeWorks Poduim

2.2  Loading the Tutorial

Figure 2.2 KnowledgeWorks Listener



2.3 Running the Tutorial
First bring up a KnowledgeWorks Listener by choosing KnowledgeWorks > Lis-
tener  from the KnowledgeWorks Podium. This brings up the Knowledge-
Works listener which accepts Lisp input as well as KnowledgeWorks input.
Type

(in-package "KW-USER")

into the Listener, and then change the current directory to that of the animals
demo by typing

(cd " lispworks-directory/examples/kw/animal")

where lispworks-directory is the location where LispWorks was installed plus
/lib/ version/ .

Load the tutorial by typing

(load "defsystem")

to load the tutorial system definition, and

(compile-system “ANIMAL" :load t)

to compile and load the rules and object base (CLOS objects). In interpreting
these two commands, the KnowledgeWorks Listener has behaved just like a
Lisp Listener. In general, whenever input has no specific KnowledgeWorks
interpretation, the KnowledgeWorks Listener just accepts it as Lisp.

2.3  Running the Tutorial
First run the tutorial example a few times. Think of an animal and type
(infer)  into the listener. infer  is a function which starts the forward chaining
engine. Popup question windows will appear, which require clicking on either
Yes or No. If your animal is guessed correctly, execution will terminate and the
listener prompt will reappear. If the final guess is incorrect then:

1. Another popup will ask what the animal was. Type in the name of an
animal and press Return (or click on OK). If the animal is already known
to the system this constitutes an error. A confirmer popup will inform
you of this; click on Confirm and execution will terminate.
7
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2. You will be asked for a question to distinguish your animal from the sys-
tem’s last guess. Type in a question (again without quotes or double-
quotes) and press Return. Execution will terminate.

3. The tutorial may be restarted by typing (infer)  again in the listener.
This time the system will know about your new animal and the question
that distinguishes it. Every time the rule interpreter finishes, it will
return and display in the listener the number of rules the forward chain-
ing engine fired.

2.4  Browsers
There are a number of browsers for examining the state of KnowledgeWorks.
They will be introduced here, and again when the Programming Environment
is discussed in Chapter 5, “The Programming Environment”.



2.4 Browsers
2.4.1  Rule Browser

Figure 2.3 KnowledgeWorks Rule Browser

This may be obtained by choosing KnowledgeWorks > Rules  from the Knowl-
edgeWorks Podium. The defined forward chaining contexts (or rule groups)
are displayed in a drop-down list at the top. There is also a special pseudo-
context for all the backward chaining rules, which is shown initially. In this
case, the only other context is named DEFAULT-CONTEXT. Below that are listed
the rules for the selected context. Choose DEFAULT-CONTEXT from the drop-
down list and click on one of the rules, for example PLAY, and edit it by choos-
ing Works > Rule > Find Source from the menu bar. An editor window will
appear showing this rule definition.

What this rule says is:
9
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(root ?r node ?node )
(not (current-node ? node ?))
-->
(assert (current-node ? node ?node) )

which means:

If the node ?node  is the root node of the tree of questions, and there is no cur-
rent node indicating the question about to be asked, then make the root node
?node  the current node (so that the top question of the tree will be asked next).
This is the rule that starts the game by instructing: “if you haven’t got a ques-
tion you’re about to ask, ask the topmost question in the tree of questions”.
The detailed syntax of forward chaining rule definitions will be explained in
Chapter 3, “Forward chaining”.

Select "-- All backward rules -- " from the drop-down list and bring up a
backward chaining rule definition by clicking on its name in the rule browser
and choosing Works > Rule > Find Source  again The detailed syntax of back-
ward chaining rules is in Chapter 3, “Backward Chaining”.
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2.4.2  Objects Browser

Figure 2.4 KnowledgeWorks Object Browser

The Objects Browser is for exploring the contents of the KnowledgeWorks
object base. It is obtained from the KnowledgeWorks Podium by choosing
KnowledgeWorks > Objects . The system knows about the CLOS objects that
make up the object base. One class of CLOS objects in this example is the NODE

class so choose Class > NODE  from the menu bar. All the node objects in the
object base will be displayed in the pane below. Click on one of these objects
and the bottom pane will display the slots and slot values of the object.

Now change the Query  field to read (node ?object animal ?a)  and press
Return. The animals associated with each node are displayed. In this game
there is a tree of questions with each node object representing a question.
11
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Some nodes have a nil  value for the animal slot; these are the non-terminal
nodes in the question tree. The program learns your new animals by adding
new nodes to the tree.

Now type ?a  into the Pattern  field (and press Return). This displays only the
animals. The values displayed in the topmost of the two panes is the Pattern
field instantiated with every possible object that matches the Query  field.
However, if the Pattern  field is empty then the value of the Query  field is taken
to be the pattern.

Change the Query  field to read (and (node ?n animal ?a) (test ?a)) and
press Return—only the non-nil  animals are displayed.
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2.4.3  Class Browser

Figure 2.5 KnowledgeWorks Class Browser

The Class Browser is obtained from the KnowledgeWorks Podium by choos-
ing KnowledgeWorks > Classes . This brings up the LispWorks Class Browser
with an initial focus on the class standard-kb-object . Go to the Hierarchy

view by clicking on the tab to display the superclass and subclass lists. Double
click on NODE in the subclasses pane to examine the node class used in this
tutorial. Go to the Slots  view to display its slots and click on one of the slots
in the middle pane, for example the ANIMAL slot, to display more information
in the bottom pane.
13
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Other useful features of the Class Browser include the Superclasses  and Sub-

classes  views which display a graph of either the subclass or the superclass
relationship, and also the Functions  view which displays the generic func-
tions or methods defined on a class either directly or through inheritance.

2.4.4  Forward Chaining History

Figure 2.6 KnowledgeWorks Forward Chaining History

This is obtained by choosing KnowledgeWorks > FC History  from the Knowl-
edgeWorks Podium. If you have just run the tutorial a window will appear of
which the left column contains the entry DEFAULT-CONTEXT. These are all the
contexts (rule groups) the forward chaining engine has executed (in this case
only one). On the right is a detailed breakdown of what happened in each
cycle within this context. You will see the rule names listed down the left, and
the cycle numbers along the top. The boxes indicate which rules fired. In the
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last cycle, you will see a black box indicating that the rule GAME-FINISHED

fired, and a outlined box for the rule PLAY. This means that the rule PLAY could
have fired, but that GAME-FINISHED was preferred.

Look at the definition for GAME-FINISHED (find the source using the Rule
Browser) and notice that it contains :priority 15 . This means that the GAME-

FINISHED  rule has higher priority than the PLAY rule (which has the default
value of 10), and so was preferred. Other methods of conflict resolution are
also available.

2.5  KnowledgeWorks Listener
The KnowledgeWorks Listener has already been shown to function as a Lisp
Listener. However it extends this with the ability of the Objects Browser to
match objects. When using the Objects Browser the Query  field contained pat-
terns which could be matched against the Object Base. These same patterns
can be typed into the KnowledgeWorks Listener. Enter (node ?object)  into
the Listener. This asks “Are there any node objects?”. A NODE object will be
returned. To ask for more solutions press “next”. If there are more you will be
shown another, otherwise the listener displays the word NO and the listener
prompt reappears. If you do not want to see any more, just press Return.

Try entering some of the other expressions from the Object Browser, for exam-
ple (and (node ?n animal ?a) (test ?a)) . If the input is not recognised it is
treated as Lisp.
15
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2.6  Debugging

2.6.1  Monitoring Forward Chaining Rules

Figure 2.7 KnowledgeWorks Rule Monitor

One of the problems with forward chaining rules is determining why they are
(or are not) being matched. To deal with this KnowledgeWorks has Monitor
Windows for forward chaining rules. To bring up a Monitor Window, select
the DEFAULT-CONTEXT in the Rule Browser, click on PLAY and choose Works >
Rule > Monitor . A window appears displaying in the top half the conditions of
the rule. Both are highlighted meaning they are matched (as single conditions
without reference to any variable bindings across conditions) in the object
base. You can click on these conditions to toggle whether they are selected.
The message “Objects match all selected items” would change from YES to NO
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depending on whether objects can be found in the object base to match all the
highlighted conditions at once (this takes account of variables bound across
conditions).

The bottom half of the window lists any unfired instantiations of the rule. In
this case there is one unfired instantiation. Clicking on this and then choosing
Instantiation > Inspect Bindings  will bring up an inspector displaying the vari-
able bindings in the instantiation.

You can have any number of monitor windows (though at most one per rule).
At times (during rule execution, for example) the object base may change.
Monitor windows can be updated by choosing choosing Tools > Update from
the monitor window menu bar, or Memory > Update Monitor Windows  from the
KnowledgeWorks Listener. When you are single-stepping through rules (see
below) Monitor windows are updated automatically.

2.6.2  Single-Stepping Rules

Figure 2.8 KnowledgeWorks Gspy Window
17
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Select a rule, say, Y-N-QUESTION, from the Rule Browser and choose Works
>Rule > GSpy  from the menu bar. This brings up a Spy Window for the rule. In
it you will see the actions of the rule. Now run the demo again (type (infer)

in the listener). Execution will stop when this rule fires. A message in the lis-
tener will say that the rule Y-N-QUESTION has been called. Click on the Creep
button at the bottom of the listener to single step through the rule. Watch the
highlight move through the Spy Window as you go. If you still have a Moni-
tor Window for the PLAY rule it will be updated automatically as you go.

Click on Leap  at the bottom of the listener and it will “leap” to the end of the
rule. When you have finished, close the Spy Window and press Leap  on the
listener window to remove the break point and continue normally.

At any point when rule execution is suspended by this mechanism, the other
KnowledgeWorks tools may be used, for example to examine the object base
(with the Objects Browser) or see which rules have fired (with the forward
chaining history). Spy Windows are available for backward chaining rules as
well, and they work in exactly the same way (they are set by clicking on the
rule in the Rule Browser and choosing Works >Rule > Gspy ).
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2.6.3  Editing Rule Definitions

Figure 2.9 KnowledgWorks Editor

Let us suppose that when the demo finishes we would like it to ask if we want
to play again. Find the definition for GAME-FINISHED (using the rule browser).
One line in the definition is commented out with a ;  (semi-colon) at the start.
Remove the semi-colon and re-evaluate the form by choosing Works >Defini-
tions > Compile from the editor menu bar. Press space to return to the editor
19
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view. This rule will now ask if the user wants to play again and execution will
only stop (the (return)  instruction ends execution) if requested. Run the
demo to see this happen.

The rule FETCH-NEW-ANIMAL also has a commented-out line (repeat) which will
make it repeat its prompt until given an animal it does not already know.
Remove the semi-colon at the start of the line in and re-evaluate the rule. Run
the demo again and try giving the system an animal it recognises. It will
prompt again. Give it an animal it does not recognise to finish.

2.7  Lisp Integration
You can save your object base of animals by typing

(save-animals "my-animal-objs.lisp")

into the listener. In the file of rules "animal-rules.lisp" look at the function
save-animals  which does this. Note how the lisp code directly uses the same
objects as the rules. If we used the lisp code to modify the slots of the objects
the KnowledgeWorks rule interpreter would keep track.

Remember: KnowledgeWorks CLOS objects are ordinary CLOS objects and
can be used outside KnowledgeWorks rules.

2.7.1  LispWorks

The entire LispWorks programming environment is available from the menus
on the KnowledgeWorks Podium. See the Common LispWorks User Guide for
more details.
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2.8  Systems

Figure 2.10 KnowledgeWorks System Browser

If you are familiar with LispWorks system definitions, look at the animal
demo’s "defsystem" file in the editor (choose KnowledgeWorks > Editor  from
the KnowledgeWorks Podium). It contains a KB-SYSTEM and a KB-INIT-SYS-

TEM. KB-SYSTEMs are reloaded when the rules are cleared. KB-INIT-SYSTEM s are
reloaded when the object base is cleared.

Try this out by finding the KnowledgeWorks Listener and choosing Memory >
Clear Objects and Rules . Then reload the system animal  (type (load-system

"ANIMAL")  into the KnowledgeWorks listener). Both the files animal-rules

and animal-objs  are reloaded. Now choose Memory > Clear Objects  and reload
the animal  system again and note how only the file animal-objs  is reloaded.
21
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2.9  Exiting KnowledgeWorks
KnowledgeWorks is integrated with LispWorks so you cannot exit from
KnowledgeWorks independently. You can close individual KnowledgeWorks
windows. You can exit LispWorks by choosing File > Exit  from the Podium. If
you have any unsaved edited files you will be asked whether you wish to save
them. There will a final confirmation before KnowledgeWorks quits.
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3Rules
KnowledgeWorks rules are defined as follows:

<rule> ::=
    (defrule <rule-name> {:forward | :backward} <body>)

Every rule must have a unique name which must also be distinct from any
KnowledgeWorks object class name and from any context (rule-group) name.
The expressions which form the body of a rule have the same syntax and
meaning regardless of whether they occur on the left or right hand side of a
forward or backward chaining rule.

3.1  Forward chaining

3.1.1  Overview

Forward chaining rules consist of a condition part and an action part. The con-
dition part contains conditions which are matched against the object base. If
and only if all the conditions are matched, the rule may fire. If the rule is
selected to fire, the actions it performs are given in the action part of the rule.
The process of selecting and firing a rule is known as the Forward Chaining
Cycle, and the forward chaining engine cycles repeatedly until it runs out of
rules or a rule instructs it to stop. KnowledgeWorks forward chaining rules
23
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reside in a group of rules, or context, and may have a priority number associ-
ated with them for conflict resolution (choosing which of a set of eligible rules
may fire).

3.1.2  Forward Chaining Syntax

Forward chaining rule bodies are defined by:

<body> ::=
          [:context <context-name>]
          [:priority <priority-number>]
          <forward-condition>* --> <expression>*)

where <context-name>  is the name of a context which has already been
defined (see Section 3.1.5, “Control Flow”) defaulting to default-context ,
and <priority-number>  is a number (see Section 3.1.5, “Control Flow”)
defaulting to 10 .

The syntax for forward-conditions is:

<forward-condition> ::=
    (<class-name> <variable> [<slot-name> <term>]*)
     |  (test <lisp-expr>)
     |  (not <forward-condition>+)

(<class-name> <variable> [<slot-name> <term>]*)  is an object-base
match where the variables (introduced by "?") in <term>  are bound (via
destructuring) to the corresponding data in the slot named by <slot-name>.

<variable>  is a single variable bound to the object matched.

Note: "?" on its own denotes an anonymous variable which always matches.

(test <lisp-expr>)  is a Lisp test where <lisp-expr>  is any Lisp expression
using the variables bound by other conditions, and which must succeed
(return non-nil ) for the condition to match. Computationally cheap Lisp tests
can frequently be used to reduce the search space created by the object base
conditions. Lisp tests, and any functions invoked by them, should not depend
on any dynamic global data structures, as changing such structures (and
hence the instantiations of the rule) will be invisible to the inference engine.

(not <forward-condition>+)  is simply a negated condition. A negated con-
dition never binds any variables outside its scope. Variables not bound before
the negation will remain unbound after it.
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Note that if a forward chaining rule contains any conditions at all then it must
contain at least one object base reference of the form

(<class-name> <variable> ...)

The syntax for expressions is:

<expression> ::=
       <forward-condition>
         |(erase <variable>)
         |(assert (<class-name> <variable>
                   [<slot-name> <term>]*))
         |(context <context-list>)
         |(return)
         |(<lisp-expr> <term>*)
         |<goal>

<forward-condition>  is a forward condition which must succeed for execu-
tion of the action part of the rule to continue.

(erase <variable>)  removes the instance bound to <variable>  from the
knowledge base. It is an error if <variable>  is bound to anything but a
KnowledgeWorks instance.

(assert (<class-name> <variable>
[<slot-name> <term>]*))

is an assertion which modifies the contents of the object base, where if <vari-

able>  is unbound a new object of the given class with the given slot-values is
created, and if it is bound, the object to which it is bound has its slots modified
to the given values.

(context <context-list>)  adds the given list of contexts to the top of
agenda (see Section 3.1.5, “Control Flow”).

(return)  passes control to the top context on the agenda and removes it from
the agenda (see Section 3.1.5, “Control Flow”).

(<lisp-expr> <term>*)  binds the result or results of calling <lisp-expr>  to
the <term> s with execution of the rule terminating if any bindings fail (if no
<term> s are given execution will always continue).

<goal>  may be any backward chaining goal expression (see Section 3.2,
“Backward Chaining”).
25
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Note that in the action part of a rule, only backward chaining goals and object
base matches invoke the backward chainer.

3.1.2.1  Example

(defrule move-train :forward
          :context train
          (train ?train position ?train-pos)
          (signal ?signal position ?signal-pos
           colour green)
          (test (= ?signal-pos (1+ ?train-pos)))
-->
  ((format t "~%Train moving to position ~s"
              ?signal-pos))
  (assert (signal ?signal colour red))
  (assert (train ?train position ?signal-pos)))

specifies that if there is a train with a green signal directly in front then the
train may move on and the signal changes to red.

3.1.3  Defining Forward Chaining Rules

Forward chaining rules may be defined and redefined incrementally. When
redefined all the instantiations of the rule are recreated. This means that
during execution of a rulebase the redefinition capability should be used with
care as previously fired instantiations will reappear and may fire again.

When a rule is redefined it inherits its order (with respect to the order  conflict
resolution tactic) from its initial definition. If this is not required, the rule
should be explicitly undefined before being redefined.

A forward chaining rule may be undefined by entering

(undefrule <rule-name>)

A warning will be given if the rule does not exist.

3.1.3.1  Example

(undefrule move-train)
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3.1.4  The Forward Chaining Interpreter

The forward chaining rule interpreter may be invoked by the Lisp function

(infer [:contexts <context-list>])

where <context-list>  is a list of contexts where control is passed immedi-
ately to the first in the list, and the rest are placed at the top of the agenda. The
object base may or may not be empty when the forward chainer is started. The
infer  function returns the final cycle number. When not specified,
<context-list>  defaults to (default-context) .

3.1.5  Control Flow

3.1.5.1  The Agenda

The agenda is essentially a stack of rule groups (called contexts) which are still
awaiting execution. The initial invocation of the forward chainer and any sub-
sequent rule can cause contexts to be added to the top of the agenda. During
normal execution the forward chainer simply proceeds down the agenda con-
text by context. When the agenda is empty, passing control on will terminate
the execution of the rule interpreter. This is a proper way to exit the forward
chainer.

3.1.5.2  Contexts

Contexts are the groups into which rules are partitioned. The context
default-context  always exists. Contexts are defined by:

<context> ::=
          (defcontext <context-name>
                      [:strategy <CRS>]
                      [:auto-return t | nil]
                      [:meta <meta-actions>])

where <context-name>  is a symbol, <CRS> is a conflict resolution strategy
defaulting to (priority recency order)  (see below). If :auto-return  is set
to t  (the default) then when the context has no more rules to fire, control
passes to the next context on the agenda, but if it is nil  an error occurs (a rule
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in the context should have issued a (return)  instruction explicitly). The :meta

option is necessary only if the default behaviour of the context is to be modi-
fied and is explained in Section 6.1.1, “Meta Rule Protocol”.

3.1.5.3  Conflict Resolution

Every context has its own conflict resolution strategy, specified in the defcon-

text  form. A conflict resolution strategy is an ordered list of conflict resolu-
tion tactics. A conflict resolution tactic may be any of the following:

• priority  — instantiations of rules with the highest priority are pre-
ferred

• -priority — instantiations of rules with the lowest priority are pre-
ferred

• recency  — the most recently created instantiations are preferred

• -recency — the least recently created instantiations are preferred

• order  — instantiations of rules defined/loaded earliest are preferred.
This favours the topmost rules in a file.

• -order — instantiations of rules defined/loaded latest are preferred

• specificity — the most specific rules are preferred (specificity is a
score where a point is awarded for every occurrence of a variable after
the first, every Lisp test, and every destructuring expression; the highest
score wins)

• -specificity — the least specific rules are preferred

• mea — (stands for Means End Analysis) instantiations are preferred
where the object corresponding to the topmost object-matching condi-
tion is more recently modified

• -mea — instantiations are preferred where the object corresponding to
the topmost object-matching condition is less recently modified

• lex — (stands for LEXicographic) each instantiation is represented by
the (in descending order) sorted list of the most recently modified cycle
numbers of the objects in the instantiation; these lists are compared
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place by place with an instantiation being preferred if it first has a larger
number in a particular position, or if it runs out first (hence the analogy
with lexicographic ordering)

• -lex — the converse of the above.

The tactics are applied successively starting with the leftmost until only one
instantiation is left or until all tactics have been applied when it is unspecified
which of the resulting set is chosen. For example, using the strategy (prior-

ity recency)  first all the instantiations which are not of the highest priority
rule or rules (as given by the rule’s priority number) are discarded and then
all instantiations which were not created in the same forward chaining cycle
as the most recently created instantiation will be discarded. If more than one
instantiation is left it is unspecified which will be selected to fire.

Note that the strategy (lex specificity)  is equivalent to the OPS5 strategy
LEX and (mea lex specificity)  is equivalent to the OPS5 strategy MEA,
hence the borrowing of these terms. For further information on LEX and MEA
in OPS5 the reader is referred to Programming Expert Systems in OPS5, by
Brownston, Farrel, Kant and Martin (published by Addison-Wesley). How-
ever, KnowledgeWorks is not heavily optimised to use the tactics mea, -mea ,
lex  or -lex .

3.1.6  Examples

(defcontext trains
            :strategy (priority recency order)
            :auto-return t)
(defcontext trains)

These two definitions are in fact equivalent.

3.1.6.1  Defining Contexts

A context may be defined and redefined. Redefining a context will clear all the
rules in the context.

A context may be undefined and removed by entering

(undefcontext <context-name>)
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3.1.7  Forward Chaining Debugging

Forward chaining debugging may be turned on by typing

code-l(all-debug)

and off by typing

(no-debug)

When KnowledgeWorks is started, debugging is on. Debugging allows the
actions of forward chaining rules to be single-stepped like backward chaining
rules (see Section 3.2.7, “Backward Chaining Debugging”), and also records
information on which objects are modified by which rules. For information on
how to use the debugging tools, refer to Chapter 5, “The Programming Envi-
ronment”.

3.2  Backward Chaining

3.2.1  Overview

Backward chaining involves trying to prove a given goal by using rules to
generate sub-goals and recursively trying to satisfy those. The Knowledge-
Works backward chaining engine is an extension of the LispWorks Common
Prolog system which can match directly over KnowledgeWorks CLOS objects
(the object base). All the standard Common Prolog facilities and built in pred-
icates are available. For more detailed information the reader is referred to the
Appendix A, “Common Prolog”. Note that all the different ways of proving a
particular goal are defined together in the same form.

3.2.2  Backward Chaining Syntax

Backward chaining rule bodies are defined as:

<body> ::= <clause>+
<clause> ::= (<goal> <-- <expression>*)
<goal> ::= (<rule-name> <term>*)
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In each sub-clause of the rule, the goal must have the same arity (number of
arguments). Within each <term>  destructuring is allowed and variables are
introduced by ? (and ? on its own denotes the anonymous variable which
always matches). <expression>  is as defined in Section 3.1.2, <Emphasis>For-
ward Chaining Syntax.

3.2.2.1  Example

(defrule link-exists :backward
  ((link-exists ?town1 ?town2)
 <--
  (or (link ?link town1 ?town1 town2 ?town2)
      (link ?link town2 ?town1 town1 ?town2))
  (cut))((link-exists ?town1 ?town2)
 <--
 (route-exists ?town1 ?town2)))

which says that a link exists between two towns either if there is a link object
between them in the object base or if there is a route between the towns. The
route-exists  predicate would be defined by another backward chaining
rule, or might be in the Prolog database.

3.2.3  Objects

Backward chaining rules may refer to the object base using the standard
(<class-name> <variable> [<slot-name> <term>]*)  syntax, and these
expressions are instantiated directly without creating any sub-goals. The
<class-name>  of any CLOS class or KnowledgeWorks structure may not coin-
cide with any backward chaining <rule-name> . The Common Prolog database
may be used to record factual information but it is distinct from the object
base in that it may contain variables, and anything in it is inaccessible to the
forward chaining rule preconditions.

3.2.4  Defining Backward Chaining Rules

Backward chaining rules may be defined and redefined incrementally.
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3.2.5  The Backward Chaining Interpreter

The backward chaining interpreter can be invoked from Lisp by the following
functions

(any <expr-to-instantiate> <expr-to-prove>)

which finds any solution to <expr-to-prove>  and instantiates <expr-to-

instantiate> , and

(findall <expr-to-instantiate> <expr-to-prove>)

finds all the solutions to <expr-to-prove> , instantiates <expr-to-instanti-

ate>  for each and returns these in a list.

For other interface functions to be called from Lisp the reader is referred to
Appendix A, “Common Prolog”.

From the action part of a forward chaining rule the backward chainer is called
implicitly when a CLOS match or goal expression is used. The action part of
forward chaining rules and the antecedents of backward chaining rules are
syntactically and semantically identical.

3.2.5.1  Examples

(any ’(?x is in (1 2 3)) ’(member ?x (1 2 3)))

returns

(1 is in (1 2 3))

The following expression:

(findall ’(?x is in (1 2 3)) ’(member ?x (1 2 3)))

returns

((1 is in (1 2 3))(2 is in (1 2 3))(3 is in (1 2 3)))

3.2.6  Edinburgh Prolog Translator

Edinburgh syntax Prolog files may be compiled and loaded if they are given
.pl  as a file extension. These are completely compatible with the Knowledge-
Works backward chaining rules. For more details refer to Section A.9, “Edin-
burgh Syntax”.



3.3 Common Lisp Interface
3.2.7  Backward Chaining Debugging

Backward chaining debugging follows the Prolog four port model. Backward
chaining rules may be “spied” (this is a Prolog term which corresponds to
tracing and single-stepping) which puts a break-point on them and means
they can be single-stepped when they are invoked. When forward chaining
debugging is on, the action part of forward chaining rules can be spied and
single-stepped in the same way when they are fired. Chapter 5, “The Pro-
gramming Environment”, explains this in detail. The leashing of the ports can
be adjusted, details are to be found in Section A.7, “Debugging”.

3.3  Common Lisp Interface
Arbitrary Lisp expressions may be called from rules. See Section 3.1.2, “For-
ward Chaining Syntax”.
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4Objects
The object base contains KnowledgeWorks CLOS objects (including relational
database objects) and KnowledgeWorks structures. KnowledgeWorks CLOS
objects can be treated as ordinary CLOS objects and may be manipulated
directly from Lisp. KnowledgeWorks relational database objects may trans-
parently retrieve their slot values from a relational database using the
LispWorks object-oriented relational database interface.

KnowledgeWorks structures are more efficient but reduced functionality
CLOS objects similar in spirit to Lisp structures. Values in the slots of these
objects should not be destructively modified unless these values are them-
selves KnowledgeWorks objects. This is because the rule interpreter keeps
track of the changes to the slots, and a destructive operation is likely to bypass
this process.

4.1  CLOS objects
A KnowledgeWorks CLOS class may not have a class name which coincides
with any rule, context or KnowledgeWorks structure (See Section 4.3, “Knowl-
edgeWorks Structures”). KnowledgeWorks CLOS classes fall into one of two
categories, either unnamed or named. Named objects can be given a name (or
they use a default name) and can be referred to by name. Otherwise, named
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and unnamed objects have equivalent functionality. CLOS objects may be
made by the Common Lisp generic function make-instance , taking the same
arguments. An unbound slot will return :UNBOUND until set.

Name clashes are arbitrated by kw:*signal-kb-name-clash*  and signal an
error by default. See the reference manual page.

4.1.1  Unnamed Classes

Unnamed classes may be defined by the macro

def-kb-class

which takes the same arguments as the defclass  macro. It is identical to using
defclass  and supplying the KnowledgeWorks mixin standard-kb-object  if
none of the superclasses already contains it. The generic function make-

instance  may be used to create instances of the class.

4.1.2  Named Classes

A named KnowledgeWorks CLOS class is defined by the macro

def-named-kb-class

which is syntactically identical to the Common Lisp defclass  macro, and
semantically identical with the exception that it adds a KnowledgeWorks
mixin class named-kb-object  if none of the superclasses already contains it,
and makes the default name for the objects be a symbol generated from the
class name. Classes defined by def-named-kb-class  contain a name slot which
those defined by def-kb-class  do not.

The function make-instance  can be given the initialisation argument :name  to
specify a name. If not specified, a default name is generated. All names must
be distinct as regarded by eq . The function

(get-kb-object <name>)

retrieves the instance from its name. The function

(kb-name <object>)

returns the name of the given object.



4.2 Relational Database Objects
4.1.2.1  Examples

(def-named-kb-class truck ()
     ((location :initarg :location)
      (destination :initarg :destination)))
(make-instance ’truck
               :kb-name ’ford1
               :location ’cambridge)

creates the instance #<KB-OBJECT FORD1>.

(make-instance ’truck :location ’london)

creates the instance #<KB-OBJECT TRUCK123>, and

(get-object ’ford1)

returns #<KB-OBJECT FORD1> and

(name (get-object ’ford1))

returns FORD1. The class definition

(defclass truck (named-kb-object) ...)

would have been identical except that the second truck would have been
given a name such as OBJECT345 rather than TRUCK123 (as def-named-kb-

class  overrides the inherited initform  for the kb-name slot (gentemp

"OBJECT")  with a more specific one (gentemp <class-name>) ).

4.2   Relational Database Objects
A LispWorks CLOS/SQL class may also be given the KnowledgeWorks mixin
class, enabling rules to refer to these objects as if there were no database
present. However, their database functionality carries over transparently. For
example, consider the case where a slot in the database class is designated for
deferred retrieval from the database. When the rulebase queries the contents
of the slot, a database query will automatically be generated to retrieve and fill
in the value of the slot, and the rulebase will continue as if the value had been
there in the first place.

Details on the LispWorks SQL interface can be found in the LispWorks Users
Guide.
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4.2.0.2  Example

(def-view-class car
               (standard-db-object standard-kb-object)
               ((car_no :db-kind :key)
                (keeper)
                (owner :db-kind :join
                       :db-info (:home-key :keeper
                                 :foreign-key person_id
                                 :retrieval :deferred
                                 :join-class person))))

defines a database class car  where the person  object in the keeper  slot is
retrieved from the person  table in the database using the value of the keeper

slot as key, only when queried. In the list of superclasses, standard-kb-

object  should appear after standard-db-object .

4.2.0.3  Extended Example

The following example is a complete segment of code which allocates person
objects to car objects. Note how once the class definitions have been made, the
rules do not in any way reflect the fact that there is an underlying database.
The example output assumes a database initialised by the following SQL
statements:

drop table CAR ;
create table CAR
  (PLATE CHAR(8) NOT NULL, MAKE CHAR(20),
   VALUE INTEGER, OWNER CHAR(20)  );
grant all on CAR to public ;
insert into CAR values
  (’E265 FOO’, ’VAUXHALL’, 5000, ’’);
insert into CAR values
  (’XDG 792S’, ’ROLLS’, 50000, ’’);
insert into CAR values
  (’F360 OOL’, ’FORD’, 4000, ’PERSEPHONE’);
insert into CAR values
  (’H151 EEE’, ’JAGUAR’, 15000, ’’);
insert into CAR values
  (’G722 HAD’, ’SKODA’, 500, ’’);
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drop table PERSON ;
create table PERSON
  (NAME CHAR(20) NOT NULL, SALARY INTEGER, CAR CHAR(8),
   EMPLOYER CHAR(20)  ) ;
insert into PERSON values (’FRED’, 10000, ’’, ’IBM’);
insert into PERSON values (’HARRY’, 20000, ’’, ’FORD’);
insert into PERSON values (’PHOEBE’, 5000, ’’, ’’ );
insert into PERSON values (’TOM’, 50000, ’’, ’ACME’ );
insert into PERSON values
  (’PERSEPHONE’, 15000, ’F360 OOL’, ’ICL’);

drop table COMPANY ;
create table COMPANY
  (NAME CHAR (20), PRODUCT CHAR(10) );
insert into COMPANY values (’IBM’, ’COMPUTERS’);
insert into COMPANY values (’FORD’, ’CARS’);
insert into COMPANY values (’ICL’, ’COMPUTERS’);
insert into COMPANY values (’ACME’, ’TEAPOTS’);

Below is an example rulebase that analyses the database and outputs a sug-
gestion as to which car should be allocated to which person. The full code and
the SQL statements to set up the database are included in the examples dis-
tributed with KnowledgeWorks.

(in-package "KW-USER")

;;; the car class maps onto the car table in the
;;; database owner is a join slot which looks up the
;;; owner person object
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(sql:def-view-class car
     (sql:standard-db-object standard-kb-object)
     ((number-plate :accessor car-number-plate
                    :type (string 8)
                    :db-kind :key
                    :column plate)
      (make :accessor car-make
            :type (string 20)
            :db-kind :base
            :column make)
      (value :accessor car-value
             :type integer
             :db-kind :base
             :column value)
      (owner-name :type (string 20)
                  :db-kind :base
                  :column owner)
      (owner :accessor car-owner
             :db-kind :join
             :db-info (:home-key owner-name
                       :foreign-key name
                       :join-class person
                       :set nil
:retrieval :deferred))))

;;; the person class maps onto the person table in the
;;; database
;;; car is a join slot which looks up the owned car
;;; object
;;; company is a join slot which looks up the company
;;; object
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(sql:def-view-class person
     (sql:standard-db-object standard-kb-object)
     ((name :accessor person-name
            :type (string 20)
            :db-kind :key
            :column name)
      (salary :accessor person-salary
              :type integer
              :db-kind :base
              :column salary)
      (car-number-plate :type (string 8)
                        :db-kind :base
                        :column car)
      (car :accessor person-car
           :db-kind :join
           :db-info (:home-key car-number-plate
                     :foreign-key number-plate
                     :join-class car
                     :set nil
                     :retrieval :deferred))
      (employer :type (string 20)
                :db-kind :base
                :column employer)
      (company :accessor person-company
               :db-kind :join
               :db-info (:home-key employer
                         :foreign-key name
                         :join-class company
                         :set nil
                         :retrieval :deferred))))

;;; the company class maps onto the company table in
;;; the database

(sql:def-view-class company
(sql:standard-db-object standard-kb-object)
     ((name :accessor company-name
            :type (string 20)
            :db-kind :key
            :column name)
      (product :accessor company-product
               :type (string 10)
               :db-kind :base
               :column product)))
41



Objects

42
;;; here we assume we have a database connected with
;;; the correct data in it - if we do we retrieve all
;;; the person and car objects but company objects will
;;; be retrieved only when needed by querying the
;;; company slot of the person objects

(if sql:*default-database*
    (progn (sql:select ’car)
           (sql:select ’person))
    (format t
            "~%Please connect to a database with
              contents ~ created by file data.sql"))
;;; to store which cars a person can drive
(def-kb-struct cars-for-person person cars)
(defcontext database-example :strategy (priority))

;;; for every person initialise the list of cars they
;;; can drive

(defrule init-cars-for-person :forward
     :context database-example
     (person ?person car nil)
     -->
     (assert
      (cars-for-person ? person ?person cars nil)))

;;; for every car a person can drive which hasn’t yet
;;; been included in the list, add it to the list

(defrule car-for-person :forward
     :context database-example
     (person ?person car nil)
     (car ?car owner nil)
     (cars-for-person ?c-f-p person ?person cars ?cars)
     (test (not (member ?car ?cars)))
                            ; has it been included?
     -->
     (car-ok-for-person ?car ?person)
                            ; check if ok to drive car
     (assert
      (cars-for-person ?c-f-p cars (?car . ?cars))))

;;; rules expressing what cars a person can drive:
;;; if they have no employer they can only drive a
;;; skoda otherwise they will refuse to drive a skoda.
;;; anyone will drive a rolls or a jag.
;;; they’ll only drive a ford or vauxhall if salary is
;;; less than 40k.
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(defrule car-ok-for-person :backward
  ((car-ok-for-person ?car ?person)
   <--
   (person ?person company nil)
   (cut)
   (car ?car make "SKODA"))
  ((car-ok-for-person ?car ?person)
   <--
   (car ?car make "SKODA")
   (cut)
   (fail))
  ((car-ok-for-person ?car ?person)
   <--
   (or (car ?car make "ROLLS")
       (car ?car make "JAGUAR"))
   (cut))
  ((car-ok-for-person ?car ?person)
   <--
   (or (car ?car make "VAUXHALL")
       (car ?car make "FORD"))
   (person ?person salary ?salary)
   (test (< ?salary 40000))))

;;; next to rules are just simple allocation rules,
;;; trying out each possibility until one fits

(defrule alloc-cars-to-persons :backward
  ((alloc-cars-to-persons ?allocs)
   <--
   (alloc-internal nil nil nil ?allocs)))
(defrule alloc-internal :backward
  ((alloc-internal ?done-persons ?done-cars
                  ?allocs ?allocs)
   <--
   (not (and (cars-for-person ? person ?person)
             (not (member ?person ?done-persons))))
   (cut))
  ((alloc-internal ?done-persons ?done-cars
                  ?allocs-so-far ?allocs)
   <--
   (cars-for-person ? person ?person cars ?cars)
   (not (member ?person ?done-persons))
   (member ?car ?cars)
   (not (member ?car ?done-cars))
   (alloc-internal (?person . ?done-persons)
                   (?car . ?done-cars)
                   ((?person . ?car) . ?allocs-so-far)
                   ?allocs)))
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;;; find a solution and print it out

(defrule find-solution :forward
  :context database-example
  :priority 5
  (not (not (cars-for-person ?)))
  -->
  (alloc-cars-to-persons ?solution)
  ((dolist (pair ?solution)
     (format t "~%~A drives ~A"
            (person-name (car pair))
            (car-number-plate (cdr pair))))))

Below is sample output from the rulebase with SQL recording turned on to
demonstrate the SQL statements that are automatically passed to the database
by manipulating the objects:



4.3 KnowledgeWorks Structures
KW-USER 53 > (infer :contexts ’(database-example))
(SELECT CAR.PLATE,CAR.MAKE,CAR.VALUE,CAR.OWNER FROM CAR
 WHERE (CAR.PLATE = ’F360 OOL’))
(SELECT CAR.PLATE,CAR.MAKE,CAR.VALUE,CAR.OWNER FROM CAR
 WHERE (CAR.PLATE = ’’))
(SELECT CAR.PLATE,CAR.MAKE,CAR.VALUE,CAR.OWNER FROM CAR
 WHERE (CAR.PLATE = ’’))
(SELECT
 PERSON.NAME,PERSON.SALARY,PERSON.CAR,PERSON.EMPLOYER
 FROM PERSON WHERE (PERSON.NAME = ’’))
(SELECT CAR.PLATE,CAR.MAKE,CAR.VALUE,CAR.OWNER FROM CAR
 WHERE (CAR.PLATE = ’’))
(SELECT
 PERSON.NAME,PERSON.SALARY,PERSON.CAR,PERSON.EMPLOYER
 FROM PERSON WHERE (PERSON.NAME = ’’))
(SELECT CAR.PLATE,CAR.MAKE,CAR.VALUE,CAR.OWNER FROM CAR
 WHERE (CAR.PLATE = ’’))
(SELECT
 PERSON.NAME,PERSON.SALARY,PERSON.CAR,PERSON.EMPLOYER
 FROM PERSON WHERE (PERSON.NAME = ’’))
(SELECT
 PERSON.NAME,PERSON.SALARY,PERSON.CAR,PERSON.EMPLOYER
 FROM PERSON WHERE (PERSON.NAME = ’’))
(SELECT
 PERSON.NAME,PERSON.SALARY,PERSON.CAR,PERSON.EMPLOYER
 FROM PERSON WHERE (PERSON.NAME = ’PERSEPHONE’))
(SELECT COMPANY.NAME,COMPANY.PRODUCT FROM COMPANY
 WHERE (COMPANY.NAME = ’FORD’))
(SELECT COMPANY.NAME,COMPANY.PRODUCT FROM COMPANY
 WHERE (COMPANY.NAME = ’ACME’))
(SELECT COMPANY.NAME,COMPANY.PRODUCT FROM COMPANY
 WHERE (COMPANY.NAME = ’IBM’))
(SELECT COMPANY.NAME,COMPANY.PRODUCT FROM COMPANY
 WHERE (COMPANY.NAME = ’’))

HARRY drives E265 FOO
TOM drives XDG 792S
FRED drives H151 EEE
PHOEBE drives G722 HAD
26

4.3   KnowledgeWorks Structures
An optimisation for improved performance is to replace CLOS objects by
KnowledgeWorks structures when the objects are not needed outside the
rules, or the full power of object-oriented programming is not required.
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Within rules they behave the same, although they are not proper CLOS
objects. This is discussed in detail in Section 6.2, “Optimisation”.
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5The Programming
Environment
The KnowledgeWorks programming environment is designed for the devel-
opment of rules. KnowledgeWorks applications will typically contain a mix-
ture of programming styles and so the LispWorks programming environment
is available from the menus on the KnowledgeWorks Podium. This chapter
deals with KnowledgeWorks specific tools but see the Common LispWorks User
Guide for more details on the LispWorks tools.

Figure 5.1 KnowledgeWorks Podium

All KnowledgeWorks windows except the Podium can be closed indepen-
dently of the others. You can switch between windows by choosing Windows >
window-name.
47



The Programming Environment

48
5.1  The KnowledgeWorks Listener

Figure 5.2 KnowledgeWorks Listener

The KnowledgeWorks Listener is obtained by choosing KnowledgeWorks > Lis-
tener  from the KnowledgeWorks Podium. This tool is based on the LispWorks
Common Prolog Logic Listener (see Appendix A, “Common Prolog” for fur-
ther details). Input is taken as being a goal expression to be satisfied unless no
predicate of that name and arity (number of arguments) exists in which case it
is taken as a Lisp expression. That is, the input may be either

<expression>

as defined in Section 3.1, “Forward chaining”, or

<lisp-expr>



5.1 The KnowledgeWorks Listener
with the former interpretation taking priority when ambiguous. Interaction is
Prolog-style, so when the bindings which satisfy a goal are printed, pressing
RETURN terminates execution, and entering ;  (semi-colon) and RETURN (or just
clicking on the Next  button at the bottom) looks for the next solution to the
goal.

The File , Leashing  and Spy  menu options behave as for the Common Prolog
Logic Listener (see Appendix A, “Common Prolog”) and the Value , Restart
and History  options behave as for the Lisp Listener (see the Common LispWorks
User Guide).
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5.2  The Editor

Figure 5.3 KnowledgeWorks Editor

The KnowledgeWorks editor is created by choosing KnowledgeWorks > Editor
from the KnowledgeWorks Podium. It is the same as the LispWorks editor.
For more information the reader is referred to the Common LispWorks User
Guide and to the Editor User Guide for information on editing commands.



5.3 Clearing KnowledgeWorks
5.3  Clearing KnowledgeWorks
The KnowledgeWorks object base (all the KnowledgeWorks CLOS objects and
any optimised structures) may be cleared by choosing Memory > Clear Objects
from the KnowledgeWorks Listener, or by calling the function reset .

KnowledgeWorks rules may be cleared by choosing Memory > Clear Rules from
the KnowledgeWorks Listener, or by calling the function clear-rules . Clear-
ing the rules does not remove the default context default-context but all the
rules in it are removed.

KnowledgeWorks object base and rules may be cleared by choosing Memory >
Clear Objects and Rules  from the KnowledgeWorks Listener, or by calling the
function clear-all . CLOS class definitions remain in effect.

5.4  The System Browser

Figure 5.4 KnowledgeWorks System Browser
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The KnowledgeWorks system browser is obtained by choosing Knowledge-
Works > Systems  from the KnowledgeWorks Podium. It is the same as the
LispWorks System Browser, but includes new types of system:

• :kb-system , which are reloaded when the KnowledgeWorks rules are
cleared (see Section 5.3 on page 51).

• :kb-init-system , which are reloaded when the KnowledgeWorks
object base is cleared (see Section 5.3 on page 51).

For more information on systems and the system tool, look in the LispWorks
documentation.
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5.5  The Class Browser

Figure 5.5 KnowledgeWorks Class Browser

The KnowledgeWorks Class Browser is obtained by choosing Knowledge-
Works > Classes  from the KnowledgeWorks Podium. It is the same as the Lisp-
Works Class Browser except that it comes up with an initial focus on
standard-kb-object  and when looking at a KnowledgeWorks class the Works
> Classes  menu contains an Inspect Instances  option to look at the instances of
the class. This presents an Inspector with a list of all the instances.
53



The Programming Environment

54
Figure 5.6 KnowledgeWorks Instances Inspector

Any of the instances displayed in the lower pane may be inspected by double-
clicking on it.

Other options available in the Class Browser include:

• Superclasses and Subclasses  tabs to draw a graphs of the subclasses or
superclasses of the class being looked at

• Slots  and Initargs  tabs to show how the instances can be accessed and
initialized.
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• Functions  tab to show the generic functions or methods defined on this
class, either directly or by inheritance

Additionally the Works > Classes  menu contains a Browse Metaclass  option to
show the class of this class.

Further details can be found in the LispWorks documentation.

5.6  The Objects Browser

Figure 5.7 KnowledgeWorks Object Browser

The Objects Browser is obtained by choosing KnowledgeWorks > Objects  from
the KnowledgeWorks Podium. Any <expression>  (See Section 3.1, “Forward
chaining”) may be entered into the Query  field, which may be a query about
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the object base or any expression for the backward chainer to prove. The Pat-
tern  field contains the pattern to be instantiated for each solution of the query.
If left blank, the pattern used is the query itself.

The instances of a class known to KnowledgeWorks (either a CLOS class or a
KnowledgeWorks structure class) may be examined by choosing Class >  class-
name. All the instances in the object base may be viewed by choosing Class >
All classes . The package used to read and print symbols may be modified by
choosing Tools > Preferences...  and entering a package name into the dialog.
Clicking OK will update the tool.

The pane below the query displays all the instantiations of the query, and if
the entries refer to an object (so are of the form (<class-name> <object>

...)  or just <object> ) clicking on them will display the slot names and val-
ues, and information on when the object was created or modified (if debug-
ging is turned on) in the bottom pane. The selected query item may be
inspected by choosing Object > Inspect .

The Objects Browser may be updated by positioning the mouse in either the
Query  or the Pattern  field and pressing Return or by choosing Tools > Update .
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5.7  The Rule Browser

Figure 5.8 KnowledgeWorks Rule Browser

The Rule Browser, obtained by choosing KnowledgeWorks > Rules  from the
KnowledgeWorks Podium, displays contexts and their rules. The drop-down
list at the top allows you to select a forward chaining context or the special
pseudo-context containing all the backward chaining rules. The lower pane
lists the rules for the selected context.

The Works > Context  menu acts on the selected context. Choosing Works > Con-
text > Find Source will bring up the definition of the context in the file where it
was defined, and choosing Works > Context > Gspy will bring up a Spy
Window (see Section 5.8, “Debugging with the Environment”) for the context,
displaying the meta-interpreter (see Section 6.1.1, “Meta Rule Protocol”) for
the context if one is defined. If debugging is turned on a meta-interpreter is
always defined. Choosing Works > Context > NoGspy  will remove the Spy
Window (see Section 5.8, “Debugging with the Environment”).
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The Works > Rule  menu acts on the rule selected in the lower pane. All rules
may be edited by choosing Works > Rule > Find Source . A Spy Windows can be
brought up or removed by choosing Works > Rule > Gspy . Forward chaining
rules may have Monitor Windows (see Section 5.8 on page 58) brought up or
removed by choosing Works > Rule > Monitor  (this is greyed out when a back-
ward chaining rule has been selected). These are explained in Section 5.8,
“Debugging with the Environment”.

The package used for displaying symbols may be modified by choosing Tools
> Preferences...  and entering a package name into the dialog. Clicking OK will
update the tool.

5.8  Debugging with the Environment

5.8.1  Spy Windows

Figure 5.9 KnowledgeWorks Gspy Window
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Spy Windows display graphically the actions or subgoals a rule (either for-
ward or backward chaining) will invoke when it fires. A Spy Window may be
obtained by choosing Works > Rule > Gspy  from the Podium or by choosing
Spy > Gspy  in the KnowledgeWorks Listener. Spying can be cancelled by clos-
ing the window itself or by choosing Spy > NoSpy or Spy > NoSpy All  from the
KnowledgeWorks Listener.

Left-clicking on one of the graph nodes in the top pane of the Spy Window
displays the full text of the box in the pane below. Right-clicking on a box and
choosing Gspy  from the resulting menu brings up a Spy Window for the goal
in the box.

When the rule being displayed fires, execution stops and the buttons at the
bottom of the KnowledgeWorks Listener allow the rule to be single-stepped.
Clicking on Creep  steps through the rule, and Leap  advances to the end of the
rule (unless any of the intervening goals invoke another rule which has been
spied). When single-stepping, a highlight marks the action or goal being per-
formed. When execution is suspended in this manner, any of the Knowledge-
Works tools or browsers may be used.

More details on single stepping through rules are in Appendix A, “Common
Prolog”.
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5.9  Monitor Windows

Figure 5.10 KnowledgeWorks Rule Monitor

Monitor Windows allow the preconditions of forward chaining rules to be
monitored. They may be obtained by choosing Works > Rule > Monitor  from the
Podium or by choosing Spy > Monitor Rule  from the KnowledgeWorks Lis-
tener.

Two panes are displayed. The topmost shows the preconditions of the rule.
Any conditions that are matched by the object base are highlighted. This high-
lighting means the condition is matched without reference to any of the other
conditions. A message entitled “Objects match all selected items” indicates by
“YES” or “NO” whether all the highlighted conditions can be matched at the
same time. A group of conditions matched individually (hence highlighted)
may not be matched together (the message would read “NO”) if, for instance,
variables were bound across them.
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The instantiations of all these highlighted conditions together can be viewed
by choosing Conditions > Instantiations which brings up the Instantiations
Viewer. The Instantiations Viewer will be empty unless the “Objects match all
selected items” message reads “YES”.

If a rule has the conditions, say,

(person ?person1 father ?person)
(person ?person2 son ?person)
(test (not (eq ?person nil)))

these would be displayed in the top pane of the Rule Monitor Window. The
first two would be highlighted if the object base contained a person object. But
the “Objects match all selected items” message would read “YES” only if there
was a person  object with the same father  value as some (other) person  object
has son .

The selection of conditions may be toggled by left-clicking. So in the above
example the last condition could be selected also by clicking on it, and the
“Objects match all selected items” message would read “NO” if the only con-
sistent value of ?person  was nil .
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Figure 5.11 KnowledgeWorks Instantiation Inspector

In the bottom pane of the window are listed all the unfired instantiations of
the rule. This list is not kept up to date if the rulebase is executing with debug-
ging turned off. If there are unfired instantiations, choosing Instantiation >
Inspect Bindings  will show the variable bindings of that instantiation in an
Inspector. Similarly, choosing Instantiation > Inspect Objects  will show the
objects themselves in an Inspector. Both these tools behave as an ordinary
LispWorks Inspectors, so double-clicking on one of the entries will cause that
entry to be inspected. See the Common LispWorks User Guide for more details.
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5.9.1  Forward Chaining History

Figure 5.12 KnowledgeWorks Forward Chaining History

The Forward Chaining History may be viewed by choosing KnowledgeWorks >
FC History  from the KnowledgeWorks Podium. It displays the rules which the
forward chaining engine has fired. The left pane lists sequentially the contexts
which have been executed, with the cycle number in which they were entered.
These can be clicked on to show in the right pane, the history for that context.
The rules in it are listed down the left, and the cycle numbers along the top,
forming a two dimensional grid.

Each position in the grid indicates the status of the rule in that cycle. A
coloured box indicates that the rule fired. A half-coloured box indicates that
the rule fired, but that the invocation of the backward chainer on the right-
hand side failed at some point. There can only be one coloured or half-
coloured box per cycle. An outlined box indicates that the rule was in the con-
flict set but was not chosen to fire. Absence of any icon indicates that the rule
was not even in the conflict set.
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If the forward chaining history is displayed while a rule is executing (for
example, while the rule is being single stepped) a half-coloured box is dis-
played as execution is not complete.

The Works > Rule  menu can be used in the same way as in the Rule Browser,
described in Section 5.7, “The Rule Browser”. It applies to the selected rule in
the FC Cycles pane.

This tool is not available when debugging is turned off.
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6Advanced Topics
6.1  Control Flow

6.1.1  Meta Rule Protocol

The meta rule protocol (MRP) reifies the internal actions of the forward
chainer in terms of backward chaining goals. This allows the user to debug,
modify, or even replace the default behaviour of the forward chainer. The
basic hooks into the Forward Chaining Cycle provided by the MRP include
conflict resolution and rule firing. Each context may have a meta-rule defined
for it which behaves as a meta-interpreter for that context. For example, if no
meta-rule is defined for a context it behaves as if it were using the following
meta-rule:

(defrule ordinary-context :backward
           ((ordinary-context)
            <--
            (start-cycle)
            (instantiation ?instantiation)
            (fire-rule ?instantiation)
            (cut)
            (ordinary-context)))
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This rule describes the actions of the forward chaining cycle for this context.
Firstly start-cycle  performs some internal initializations and updates the
conflict set. It is essential that this is called at the start of every cycle. Next the
preferred instantiation is selected from the conflict set by the call to instanti-

ation  and is stored in the variable ?instantiation . The rule corresponding to
this is fired (by fire-rule ) and the recursive call to ordinary-context  means
that the cycle is repeated. The cut  is also essential as it prevents back-tracking
upon failure. Failure occurs when there are no more instantiations to fire (the
instantiation  predicate fails) and this causes control to be passed on as nor-
mal.

A meta-rule may be assigned to a context with the :meta  keyword of the def-

context  form. The argument of the :meta  keyword is the list of actions to be
performed by the context. For example, a context using the above ordinary
meta-interpreter can be defined by

(defcontext my-context :meta ((ordinary-context)))

This implicitly defines the rule

(defrule my-context :backward
         ((my-context)
          <--
          (ordinary-context)))

and whenever this context is invoked, the rule of the same name is called. The
context could equally well have been defined as

(defcontext my-context :meta
            ((start-cycle)
             (instantiation ?instantiation)
             (fire-rule ?instantiation)
             (cut)
             (my-context)))

Sometimes it is useful to manipulate the entire conflict set. For this purpose
the action (conflict-set ?conflict-set)  will return the entire conflict set in
the given variable, in the order specified by the context’s conflict resolution
strategy. The actions

(conflict-set ?conflict-set)
(member ?instantiation ?conflict-set)

are equivalent to
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(instantiation ?instantiation)

although the latter is more efficient.

Now that the user has access to the instantiations of rules, functions are pro-
vided to examine them.

6.1.1.1  Functions defined on Instantiations

The following functions may be called on instantiations:

inst-rulename (instantiation)

which returns the name of the rule of which this is an instantiation.

inst-token (instantiation)

which returns the list of objects (the token) which match the rule. These appear
in reverse order to the conditions they match.

inst-bindings (instantiation)

which returns an a-list of the variables matched in the rule and their values.

6.1.1.2  A Simple Example

This meta-rule displays the conflict set in a menu to the user and asks for one
to be selected by hand on each cycle. Note that we have to check both that
there were some instantiations available, and that the user selected one (rather
than clicking on the Abort button).

(defrule manual-context :backward
         ((manual-context)
          <--
          (start-cycle)
          (conflict-set ?conflict-set)
          (test ?conflict-set)
                   ; are there any instantiations?
          ((select-instantiation ?conflict-set)
           ?instantiation)
          (test ?instantiation)
                   ; did the user pick one?
          (fire-rule ?instantiation)
          (cut)
          (manual-context)))
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where the function select-instantiation  could be defined as

(defun select-instantiation (conflict-set)
        (tk:scrollable-menu conflict-set
            :title "Select an Instantiation:"
            :name-function #’(lambda (inst)
                              (format nil "~S: ~S"
                                (inst-rulename inst)
                                (inst-bindings inst))))

Now a context could be defined by

(defcontext a-context :strategy ()
                     :meta ((manual-context)))

6.1.1.3  A Simple Explanation Facility

Meta-rules can also be used to provide an explanation facility. A full imple-
mentation of the explanation facility described here is included among the
examples distributed with KnowledgeWorks, and is given also in
Appendix B.2, “Explanation Facility”

Suppose we have a rule about truck scheduling of the form

(defrule allocate-truck-to-load :forward
          (load ?l size ?s truck nil destination
           ?d location ?loc)
          (test (not (eq ?d ?loc)))
          (truck ?t capacity ?c load nil location ?loc)
          (test (> ?c ?s))
           -->
          (assert (truck ?t load ?l))
          (assert (load ?l truck ?t)))

and we wish to add an explanation by entering a form like
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(defexplain allocate-truck-to-load
             :why ("~S has not reached its destination
                   ~S and ~ does not have a truck
                   allocated, ~ ~S does not have a load
                   allocated, and ~ with capacity ~S is
                   able to carry the load, ~ and both
                   are at the same place ~S"
                   ?l ?d ?t ?c ?loc)
             :what ("~S is scheduled to carry ~S to ~S"
                    ?t ?l ?d)
             :because ("A customer requires ~S to be
                       moved to ~S" ?l ?d))

where the :why  form explains why the rule is allowed to fire, the :what  form
explains what the rule does and the :because  gives the ultimate reason for
firing the rule.

The stages in the implementation are as follows:

• Define a macro called defexplain  to store the explanation information
in, say, a hash-table keyed against the rule name

• Define a function add-explanation  takes an instantiation, fetches the
explanation information from the hash-table and the variable bindings
in the instantiation, and adds the generated explanations to another
global data structure, something like:

(defun add-instantiation (inst)
  (let ((explain-info
         (gethash (inst-rulename inst)
                  *explain-table*)))
       (when explain-info
         (do-the-rest explain-info
            (inst-bindings inst))))))

• Implement graphical tools to browse the resulting explanations

• Define a meta-interpreter for which will produce explanations, for
example:
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(defrule explain-context :backward
  ((explain-context)
   <--
   (start-cycle)
   (instantiation ?inst)
   ((add-explanation ?inst))
   (fire-rule ?inst)
   (cut)
   (explain-context)))

6.1.1.4  Reasoning with Certainty Factors

Another application of meta-rules is in the manipulation of uncertainty. A full
implementation of the uncertain reasoning facility described below is
included among the examples distributed with KnowledgeWorks, and also in
Appendix B.3, “Uncertain Reasoning Facility”.

In this example, we wish to associate a certainty factor with objects in a manner
similar to the MYCIN system (see Rule-Based Expert Systems, B. G. Buchanan
and E. H. Shortliffe, Addison-Wesley 1984). When we assert an “uncertain”
object we wish it to acquire the certainty factor of the instantiation which is fir-
ing. We define the certainty factor of an instantiation to be the certainty factor
of all the objects making up the instantiation multiplied together. Addition-
ally, we wish rules to have an implication strength associated with them which
is a multiplicative modifier to the certainty factor obtained by newly asserted
uncertain objects. The general approach is as follows:

• Define global variables *c-factor*  to hold the certainty factor of the
current instantiation and *implic-strength*  to hold the implication
strength of the rule, and a class of “uncertain” KnowledgeWorks
objects:

(def-kb-class uncertain-kb-object ()
 ((c-factor :initform (* *c-factor* *implic-strength*)
            :accessor object-c-factor)))

The uncertain objects should contain this class as a mixin.

• Define a function to obtain the certainty factor of instantiations:

(defun inst-c-factor (inst)
  (reduce ’* (inst-token inst) :key ’object-c-factor))
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• Define a conflict resolution tactic to prefer either more or less certain
instantiations (See Section 6.1.2, “User-definable Conflict Resolution”
for details).

• Define a meta-rule to set the global certainty factor to the certainty
factor of the instantiation about to fire:

(defrule uncertain-context :backward
   ((uncertain-context)
    <--
    (start-cycle)
    (instantiation ?inst)
    ((setq *c-factor* (inst-c-factor ?inst)))
     (fire-rule ?inst)
     (cut)
     (uncertain-context)))

• Define a function implication-strength which sets the variable *implic-

strength*  so that rules may set their implication strength by calling the
action:

       ((implication-strength <number>))

A rule could be defined similarly to:

(defrule my-rule :forward
   (my-class ?obj1)
   (my-class ?obj2)
   -->
   ((implication-strength 0.6))
   (assert (my-class ?obj3)))

where the certainty factor of the new object ?obj3  will automatically
become:

(* (object-c-factor ?obj1) (object-c-factor ?obj2) 0.6)

While this is an extremely simplistic version of uncertain reasoning, it sug-
gests how a more elaborate treatment might be approached.
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6.1.2  User-definable Conflict Resolution

A conflict resolution strategy is a list of conflict resolution tactics. A conflict
resolution tactic is a function which takes as arguments two rule instantia-
tions, and returns t  if and only if the first is preferred to the second, otherwise
NIL . A conflict resolution tactic may be defined by

(deftactic <tactic-name> {<type>} <lambda-list> <body>)

where <tactic-name>  is the name of the tactic and of the function being
defined which implements it, and <lambda-list>  is a two argument lambda-
list. <type>  may be either :static  or :dynamic , defaulting to :dynamic . A
dynamic tactic is one which looks into the objects which match the rule to
make up the instantiation; a static one does not. For example, a tactic which
prefers instantiations which match, say, truck objects to instantiations which
do not could be defined as static. However, if it looks into the slot values of the
truck object it should be defined as dynamic. Static tactics are treated more
efficiently but wrongly declaring a tactic as static will lead to incorrect conflict
resolution.

It is an absolute requirement that there exist no instantiations for which

(<tactic-name> <instantiation1> <instantiation2>)

and

(<tactic-name> <instantiation2> <instantiation1>)

both return t . Consequently, for any single given instantiation

(<tactic-name> <instantiation> <instantiation>)

must return nil .

The function which defines a conflict resolution tactic should be computation-
ally cheap as it is used repeatedly and frequently to compare many different
pairs of instantiations.

6.1.2.1  Examples

The following tactic prefers instantiations with truck objects to ones without
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(deftactic prefer-trucks :static (inst1 inst2)
   (flet ((truck-p (obj) (typep obj ’truck)))
        (and (some #’truck-p (inst-token inst1))
             (notany #’truck-p (inst-token inst2)))))

Note that this tactic would be incorrect if we did not check that the second
instantiation does not refer to any trucks (otherwise it would always return t

if both instantiations contain trucks). It can safely be declared as static as it
does not look into the slots of the objects which make up the instantiation.

This tactic implements alphabetical ordering on rule names:

(deftactic alphabetical-rulename :static (inst1 inst2)
   (string< (symbol-name (inst-rulename inst1))
            (symbol-name (inst-rulename inst2))))

This tactic prefers instantiations which bind the variable ?x  to zero:

(deftactic prefer-?x=0 :dynamic (inst1 inst2)
   (flet ((fetch-?x (inst)
            (cdr (assoc ’?x (inst-bindings inst)))))
         (and (eql 0 (fetch-?x inst1))
              (not (eql 0 (fetch-?x inst2))))))

Note that again we must not forget to check that ?x  is not zero in the second
instantiation. This tactic must be declared dynamic as ?x  must have been
instantiated from the slots of one of the matched objects.

The final tactic is for the example of uncertain reasoning and implements a
method of preferring “more certain” instantiations:

(deftactic certainty :dynamic (inst1 inst2)
   (> (inst-c-factor inst1) (inst-c-factor inst2)))

This tactic must be dynamic if the certainty factors of objects can be modified
after creation. If this is forbidden the tactic could be defined as static. Then the
context defined by

(defcontext my-context :strategy (priority certainty))

will prefer instantiations of rules with higher priority or, if this does not dis-
criminate sufficiently, instantiations which are "more certain".
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6.2  Optimisation

6.2.1  Forward Chaining

6.2.1.1  KnowledgeWorks Structures

A CLOS class may be replaced by a structure for increased speed when all the
power of CLOS is not needed. Within the rule interpreter the structure
behaves like a CLOS class which:

• Has an initform  of nil  for each slot

• Has the keyword version of the slot name as initarg for each slot

• Has only single inheritance

• Has no methods defined on it

• Should not be modified from Lisp after its creation.

A KnowledgeWorks structure is defined by the macro

(def-kb-struct <class-spec> <slot-spec>*)

where the arguments are the same as for defstruct  except that in <class-

spec>  only the options :include  and :print-function  are allowed. A struc-
ture may only be included in a KnowledgeWorks structure if it too is a Knowl-
edgeWorks structure defined by def-kb-struct . All the functions normally
provided by defstruct  (accessors, a predicate etc.) are generated. An instance
of the structure class may be created by the generic function

(make-instance <class-name>
             {<slot-specifier> <value>}*)

where <slot-specifier>  is the keyword version of the slot name, as with any
structures, and <value>  is the value the slot is to take, otherwise defaulting to
the value specified in the def-kb-struct  form. If created from Lisp by any
means other than make-instance  (for example, by the automatically defined
make-<structure-name>  constructor), the inference engine will not know
about the structure.

Once created, structures must not be modified directly from Lisp as this will
corrupt the state of the forward chaining inference engine. For example:
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(def-kb-struct train position speed)
(def-kb-struct signal position colour)
(make-instance ’train :position 0 :speed 80)
(make-instance ’signal :position 10 :colour ’red)

defines KnowledgeWorks structures for trains and signals and makes an
instance of each. Note that they are not fully-fledged CLOS objects but are
analogous to working memory elements in OPS5.

6.2.1.2  Efficient Forward Chaining Rule Preconditions

Forward chaining rules are more efficient if the more restrictive preconditions
(that is, the ones which will have fewer matches) are written first. Computa-
tionally cheap Lisp tests should be used wherever possible as they reduce the
search space of the rule interpreter. The Lisp tests should where possible be
broken into sufficiently small pieces that they can be applied as early on as
possible.

For example, the precondition fragment

(train ?t position ?p1)
(test (> ?p1 5))
(signal ?s position ?p2)
(test (> ?p2 6))

is better than

(train ?t position ?p1)
(signal ?s position ?p2)
(test (and (> ?p1 5) (> ?p2 5)))

because in the first example the Lisp tests can be applied directly to the trains
and signals respectively before looking at combinations of trains and signals,
whereas in the second case all the combinations must be produced before the
Lisp test can be applied. Simply  separating the tests is enough for the rule
compiler to apply them to the right object base matches — the precise order of
the tests is unimportant.
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6.2.2  Conflict Resolution

6.2.2.1  Use of Contexts

The single most significant way to improve conflict resolution time is to
divide the rulebase up into contexts. The time taken by conflict resolution is
dependent on the total number of instantiations of all the rules in the context
so the fewer rules in each context, the more efficient conflict resolution will be.

6.2.2.2  Optimisation of the Strategy

A conflict resolution strategy may be optimised by combining the constituent
tactics in a more effective manner. There are three different types of conflict
resolution tactic:

• Rule-defined (meaning the tactic relies only on the rule of the instantia-
tion and on nothing else), including priority , -priority , order , -

order , specificity  and -specificity

• Static (meaning the tactic does not look into the slots of the matched
objects which make up the instantiation), including recency  and -

recency , and

• Dynamic (meaning the tactic may look into the objects making up the
instantiation), including mea, -mea , lex  and -lex .

KnowledgeWorks is best able to optimise rule-defined tactics and least able to
optimise dynamic tactics. The optimisations for a particular type of tactic can
only be applied if it is preceded only by tactics which can be optimised to the
same degree (or better). For example, in the strategy (recency priority) , the
tactic priority  would only be optimised as a static tactic. In the strategy
(priority mea recency) , priority  can be optimised as a rule-defined tactic
but recency  will be treated as a dynamic tactic.

Some final points to bear in mind:

• Tactics which tend to prefer existing instantiations over newer ones (for
example -mea , -lex  and -recency ) will degrade performance

• recency  and lex  have similar functionality but recency  is more effi-
cient.
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6.2.3  Backward Chaining

6.2.3.1  Pattern Matching

The KnowledgeWorks Backward Chainer indexes clauses for a backward rule
based on the first argument. If the first arguments to backward rule clauses
are distinct non-variables, the backward chainer can pre-select possible
matching clauses for a call.

For example, in the following rule:

(defrule age-of :backward
                ((age-of charlie 30) <--)
                ((age-of william 25) <--)
                ((age-of james 28) <--))

The call: (age-of james ?x)  would jump directly to the third clause and bind
?x  to 28 without trying the other two.

The call: (age-of tom ?x)  would fail immediately without doing any pattern
matching.

Clauses are distinguished first by the types and then the values of their first
arguments.

6.2.3.2  Tail Recursion

The KnowledgeWorks Backward Chainer supports the transformation of
“tail-recursive” calls into jumps. Thus, stack overflow can be avoided without
resorting to “repeat, fail” loops in most cases. For example, given the defini-
tion:

(defrule run-forever :backward
                    ((run-forever)
                    <--
                     (run-forever)))

the call: (run-forever)  will run forever without generating a stack over-
flow.   Note that this optimization is not limited to recursive calls to the same
rule. The last call of any rule will be compiled as a jump, drastically reducing
stack usage.
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6.2.3.3  Cut

The use of “cut” is a well known performance enhancement for Prolog-style
rules. In KnowledgeWorks it does more than reduce the time spent in search.
When a “cut” is invoked, all the stack space between the initial call to the con-
taining rule and the current stack location is reclaimed immediately, and can
have a significant impact on the total space requirements of a program.

6.3  Use of Meta-Classes
Objects of meta-classes other than standard-class  may be made available to
KnowledgeWorks by including the KnowledgeWorks mixin standard-kb-

object . This requires

• The existence of a validate-superclass  method allowing standard-

kb-object  (meta-class standard-class ) to be a superclass of the class
being defined with a different meta-class

• That the meta-class in question does not implement any particularly
strange behaviour on slot access, for example, if querying a slot value
results in setting it.

6.3.0.4  Example

A meta-class standard-kb-class  could be defined as a KnowledgeWorks
class. New KnowledgeWorks classes (or even ordinary non-KnowledgeWorks
classes) could be defined with this meta-class. KnowledgeWorks could then
reason about the instances of the classes and about the class objects them-
selves. The code below implements this:

(def-kb-class standard-kb-class (standard-class) ())
(defmethod validate-superclass
           ((class standard-kb-class)
            (superclass standard-class))
           t)
(def-kb-class foo () ((slot))
                    (:metaclass standard-kb-class))

Then when the following rule fires:



6.3 Use of Meta-Classes
(defrule find-kb-class :forward
  (standard-kb-class ? clos::name ?n)
  -->
  ((format t "~%I can reason about class ~s" ?n)))

it will output:

I can reason about class FOO
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7Reference Guide
The symbols documented in the following pages are all external in the KW
package unless stated otherwise. They are listed in alphabetical order.

all-debug Function

Syntax all-debug

Arguments None.

Description Turns on all KnowledgeWorks debugging facilities. This
means that rules and contexts can be single stepped and
monitored, and a record is kept of whenever objects are cre-
ated or modified.

Values nil

Examples (all-debug)

See Also no-debug
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any Function

Syntax any pattern-to-instantiate goal-to-prove

Arguments pattern-to-instantiate is a list or symbol. goal-to-prove is any
backward chaining goal.

Description The backward chaining inference engine is started to look for
any set of bindings which satisfy goal-to-prove. Using those
bindings, pattern-to-instantiate is instantiated and returned.

Values Two values are returned. The second value indicates with T

that a proof was found, or with nil  that no proof exists. In
the former case, the first value is the instantiated version of
pattern-to-instantiate, in the latter case, the first value is nil .

Examples (any ’(?x is in (1 2 3)) ’(member ?x (1 2 3)))

returns (1 is in (1 2 3))

(any ’(?truck is a truck) ’(truck ?truck))

returns (#<TRUCK TRUCK5> IS A TRUCK)

See Also findall

assert Backward Chaining Goal

Syntax assert ( class-name variable { slot-name term}*)

Arguments class-name is the name of a class of objects known to Knowl-
edgeWorks. variable is a variable beginning with ?. slot-name
is the name of a slot in the class. term is an expression com-
posed of Lisp data structures and KnowledgeWorks vari-
ables.



Description If variable is unbound a new instance of class class-name is cre-
ated with the named slots containing the value of the term
immediately following the slot name. If variable is bound,
that bound instance has its named slots modified to contain
the value of the term immediately following the slot name. It
is an error if the bound object is not of the named class.

It is an error to put an unbound variable into a slot of an
object in the object base.

Examples (assert (truck ?truck driver ?driver))
(assert (possible-trucks ? trucks (?truck . ?trucks))

See Also erase

clear-all Function

Syntax clear-all

Arguments None.

Description Clears contexts, rules and objects. The list of Knowledge-
Works classes remains unaffected. The default context
default-context  is not removed, but all rules in it are.

Values nil

Examples (clear-all)

See Also clear-rules

reset

clear-rules Function

Syntax clear-rules
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Arguments None.

Description Clears contexts and rules. The list of KnowledgeWorks
classes remains unaffected. The default context default-

context  is not removed, but all rules in it are.

Values nil

Examples (clear-rules)

See Also clear-all

reset

conflict-set Backward Chaining Goal

Syntax conflict-set variable

Arguments variable should be an unbound KnowledgeWorks variable
introduced by ?.

Description Binds variable to the list of all existing rule instantiations in
the currently executing context. This list is in the order pre-
ferred by the conflict resolution strategy for the context.

Examples (conflict-set ?conflict-set)

See Also instantiation

fire-rule

context Backward Chaining Goal

Syntax context context-list



Arguments context-list is a list of context names. Bound variables may be
used.

Description The given list of contexts is placed on top of the agenda (the
context stack). The current context is not changed. It is an
error if the named contexts do not exist.

Examples (context (my-context))
(context (?x ?y)) ; if ?x ?y bound to context names

See Also return

cut Backward Chaining Goal

Syntax cut

Arguments None.

Description cut  is a standard prolog predicate. When first called it suc-
ceeds and freezes certain choices made by the backward
chainer up to this point. It may no longer attempt to resatisfy
any of the goals between the start of clause and the cut , and
it may not attempt to use any other clauses to satisfy the
same goal.

Examples (defrule nice :backward
  ((nice ?x)
   <--
   (rottweiler ?x)
   (cut)
   (fail))
  ((nice ?x) <--))

implements “everything is nice unless it is a rottweiler”. First
the backward chainer will attempt to prove (nice fido)

with the first clause. If fido  is a rottweiler the cut  then pre-
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vents the backward chainer from using the second clause
which says “everything is nice”. The fail ensures that (nice

fido)  fails.

*cycle* Variable

Description The current cycle number of the forward chaining rule inter-
preter. If the forward chaining rule interpreter is not running
it gives the total number of cycles executed by the forward
chaining rule interpreter the last time it ran. If the forward
chaining rule interpreter has not run at all it gives the value
zero.

Initial Value 0

def-kb-class Macro

Syntax def-kb-class class-name superclass-list slot-descriptions &rest
options

Arguments The arguments are identical to those for defclass .

Description Defines a new CLOS class as defclass  does. However, if
none of the given superclasses is a subclass of standard-kb-

object , then standard-kb-object  is added to the list of
superclasses.

Values Returns the class object.

Examples (def-kb-class vehicle () ((driver :initarg :driver)))
(def-kb-class truck (vehicle)
  ((load :accessor truck-load)))

See Also def-named-kb-class

def-kb-struct



def-kb-struct Macro

Syntax def-kb-struct name-and-options { slot-description}*

Arguments The arguments are as for defstruct , except that in name-and-
options the only valid options are :include  and :print-

function .

Description Defines a KnowledgeWorks structure. These are analogous to
Lisp structures except that they may be used in rules simi-
larly to CLOS objects.

Values Returns the name of the structure.

Examples (def-kb-struct start)
(def-kb-struct (named-kb-struct
  (:print-function print-named-kb-struct))
  (name (gensym ’named-kb-struct)))

(def-kb-struct (possible-trucks-for-load
  (:include named-kb-struct))
  load trucks)

See Also def-kb-class

def-named-kb-class Macro

Syntax def-named-kb-class class-name superclass-list slot-descriptions
&rest options

Arguments The arguments are identical to those for defclass .

Description Defines a new CLOS class as defclass  does. However, if
none of the given superclasses is a subclass of named-kb-

object , then named-kb-object  is added to the list of super-
classes. The class inherits a name slot kb-name  of which the
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initialisation form (:initform ) generates a symbol from the
class name using gentemp  (See Steele, Common Lisp: the Lan-
guage).

Values Returns the class object.

Examples (def-named-kb-class vehicle ()
  ((driver :initarg :driver)))
(def-named-kb-class truck (vehicle)
  ((load :accessor truck-load)))

See Also def-kb-class

def-kb-struct

get-kb-object

kb-name

defcontext Macro

Syntax defcontext context-name &key ( refractoriness t) ( auto-return t)
strategy meta

Arguments context-name is the name of the context being defined. refracto-
riness may be t  or nil  and indicates whether a given rule
instantiation may fire more than once. auto-return may be
t or nil  and indicates whether to signal an error if no more
rules are eligible to fire in the context. meta is a list of actions.

Description Defines a context of the given name and parameters. If a con-
text of the given name already exists then it, and all the rules
in it, are first removed. If refractoriness is set to nil  then a rule
instantiation remains eligible to fire again after firing once.
auto-return indicates, when there are no more rules to be fired
in the context, whether to signal an error or simply to pass
control to the next context on the agenda. The default value t



passes control on without an error. strategy is the conflict res-
olution strategy for the context. meta is a list of actions which
make up the optional meta-interpreter for the context.

Values Returns the list (CONTEXT context-name) .

Examples (defcontext my-context :strategy (priority recency))
(defcontext another-context :strategy (order)
  :meta ((start-cycle)
         (instantiation ?inst)
         (fire-rule)
         (cut)
         (another-context)))

See Also standard-context

-lex

lex

-mea

mea

-order

order

-priority

priority

-recency

recency

-specificity

specificity

defrule Macro

Syntax defrule rule-name direction &rest body
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Arguments rule-name is a symbol. direction is :forward  or :backward . The
body is described in Chapter 3, Rules.

Description Defines a rule of the given name (which must be distinct
from any other rule name, context name or KnowledgeWorks
class name). If direction is :forward  a forward chaining rule is
defined, if :backward  a backward chaining rule is defined. A
full description is given in Chapter 3, <Emphasis>Rules.

Values rule-name is returned.

Examples (defrule move-train :forward :context trains
  (train ?train position ?train-pos)
  (signal ?signal position ?signal-pos colour green)
  (test (= ?signal-pos (1+ ?train-pos)))
  -->
  ((format t "~%Train moving to ~S" ?signal-pos))
  (assert (signal ?signal colour red))
  (assert (train ?train position ?signal-pos)))
(defrule link-exists :backward
  ((link-exists ?town1 ?town2)
   <--
   (or (link ?link town1 ?town1 town2 ?town2)
       (link ?link town2 ?town1 town1 ?town2))
   (cut))
  ((link-exists ?town1 ?town2)
   <--
   (route-exists ?town1 ?town2)))

deftactic Macro

Syntax deftactic tactic-name type lambda-list &rest body

Arguments tactic-name is a symbol. type is either :static  or :dynamic .
lambda-list is a two argument lambda-list. body is a function
body.



Description Defines a new conflict resolution tactic of the given name.
The type of the tactic may be :static  if the body does not
look into the slots of the objects making up the instantiation,
otherwise :dynamic . The lambda-list binds to two instantia-
tion objects and the function body body should return non-
nil  if and only if the first instantiation object is preferred to
the second. deftactic  also defines a function of the same.

The newly defined tactic may be used as any in-built tactic.

Values Returns tactic-name.

Examples (deftactic prefer-trucks :static (inst1 inst2)
  (flet ((truck-p (obj) (typep obj ’truck)))
    (and (some #’truck-p (inst-token inst1))
      (notany #’truck-p (inst-token inst2)))))

The new tactic may be used in a defcontext  form:

(defcontext my-context :strategy (prefer-trucks))

See Also inst-bindings

inst-token

inst-rulename

erase Backward Chaining Goal

Syntax erase variable

Arguments variable is bound to a KnowledgeWorks object (either a
KnowledgeWorks CLOS object or a KnowledgeWorks struc-
ture).

Description Removes the object given by variable from the object base.

Examples (erase ?x) ; ?x bound to an object

See Also assert
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fail Backward Chaining Goal

Syntax fail

Arguments None.

Description This goal always fails. It is sometimes used with cut.

Examples (defrule nice :backward
  ((nice ?x)
   <--
   (rottweiler ?x)
   (cut)
   (fail))
  ((nice ?x) <--))

implements “everything is nice unless it is a rottweiler”.

See Also cut

findall Function

Syntax findall pattern-to-instantiate goal-to-prove

Arguments pattern-to-instantiate is a list or symbol. goal-to-prove is any
backward chaining goal.

Description The backward chaining inference engine is started to look for
all sets of bindings which satisfy goal-to-prove. Using those
each of bindings, pattern-to-instantiate is instantiated and
returned as a list.

Values A list is returned containing zero or more occurrences of pat-
tern-to-instantiate, each instantiated with a different set of
bindings which satisfies goal-to-prove.

Examples (findall ’(?x is in (1 2 3)) ’(member ?x (1 2 3)))

returns



((1 is in (1 2 3))
 (2 is in (1 2 3))
 (3 is in (1 2 3)))

(findall ’(?truck is a truck) ’(truck ?truck))

returns

((#<TRUCK TRUCK1> IS A TRUCK)
 (#<TRUCK TRUCK2> IS A TRUCK))

See Also any

fire-rule Backward Chaining Goal

Syntax fire-rule instantiation

Arguments instantiation is an instantiation object.

Description Fires the given rule instantiation. An error results if the
passed object is not an instantiation object.

Examples (fire-rule ?instantiation)

See Also conflict-set

inst-bindings

inst-rulename

inst-token

instantiation

get-kb-object Function

Syntax get-kb-object object-name

Arguments object-name is a symbol.
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Description Returns the KnowledgeWorks object named object-name. If
there is no such object an error results.

Values A KnowledgeWorks CLOS object.

Examples (get-kb-object ’fred)

See Also def-named-kb-class

kb-name

*in-interpreter* Variable

Description Returns t  if the code executing has been called (directly or
indirectly) from the forward chaining rule interpreter. Other-
wise it returns nil .

Initial Value nil

infer Function

Syntax infer &key ( contexts ’(default-context))

Arguments contexts is a list of context names.

Description Starts the forward chaining inference engine with contexts as
the initial agenda. The first rules to fire will be from the first
context listed in contexts until control is passed on.

Values The total number of cycles executed (given in *cycle* ).

Examples (infer :contexts ’(my-context another-context))

See Also *cycle*



inst-bindings Function

Syntax inst-bindings instantiation

Arguments instantiation is an instantiation object.

Description Returns an association list of the variables and their bindings
in the instantiation. The variables are those produced by the
condition part of the forward chaining rule.

Values An association list, of the form ((?A . 1) (?B . RED)) .

See Also conflict-set

deftactic

inst-rulename

inst-token

instantiation

inst-rulename Function

Syntax inst-rulename instantiation

Arguments instantiation is an instantiation object.

Description Returns the rule name of the instantiation. (The name of the
rule of which this is an instantiation).

Values A symbol which is the name of a rule.

See Also conflict-set

inst-bindings

deftactic

inst-token
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instantiation

inst-token Function

Syntax inst-token instantiation

Arguments instantiation is an instantiation object.

Description Returns the token of the instantiation. The token is the list of
objects which match the condition part of the forward chain-
ing rule. This list of objects is in reverse order to the order in
which the conditions appear in the rule. For example, if the
forward chaining conditions are

(train ?train)
(signal ?signal)

then the token will have the form ( signal-object train-object) .

Values The token of the instantiation (a list of objects).

See Also conflict-set

deftactic

inst-rulename

inst-bindings

instantiation

instantiation Backward Chaining Goal

Syntax instantiation variable

Arguments variable should be an unbound variable introduced by ?.



Description Binds variable to the next preferred instantiation from the
conflict set of the currently executing context. This goal may
be satisfied repeatedly each time returning the next instantia-
tion. When no instantiations are left, it fails.

Values variable is bound to an instantiation object if one is available.

Examples (instantiation ?instantiation)

See Also conflict-set

deftactic

inst-rulename

inst-bindings

inst-rulename

inst-token

standard-context

kb-name Generic Function

Syntax kb-name object

Arguments object is a KnowledgeWorks named CLOS object

Description Returns the name of the object. It is an error if the object is not
a named object.

Values A symbol which is the name of the object.

Examples (kb-name (get-kb-object ’fred))  ; returns FRED

See Also def-named-kb-class

get-kb-object
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kw-class Backward Chaining Goal

Syntax kw-class term

Arguments term may be any backward chaining term.

Description This goal can act as a generator and is resatisfiable. It suc-
ceeds when term is a symbol which is the name of a Knowl-
edgeWorks class. If term is an unbound variable it generates
the names of the KnowledgeWorks classes.

Values term is bound to the names of KnowledgeWorks classes.

Examples (kw-class truck)  ; succeeds if truck is a KW class

(kw-class ?class)
  ; ?class binds to the name of a KW class

See Also def-kb-class

def-kb-struct

def-named-kb-class

-lex Conflict Resolution Tactic / Function

Syntax -lex instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic -

lex , otherwise nil . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Values A single value, either nil  or non-nil .



Examples (defcontext my-context1 :strategy (-lex))
(defcontext my-context2 :strategy (priority -lex))

See Also defcontext

deftactic

lex

instantiation

conflict-set

fire-rule

lex Conflict Resolution Tactic / Function

Syntax lex instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic lex ,
otherwise nil . The function is intended to be used primarily
by including it in the conflict resolution strategy for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (lex))
(defcontext my-context2 :strategy (priority lex))

See Also defcontext

deftactic

-lex

instantiation

conflict-set

fire-rule
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make-instance Generic Function

Syntax make-instance class &rest initargs

Arguments class is a class object or a symbol that names a class. initargs
are the initialisation arguments for the class.

Description A new instance of class class is made. The class may be either
a CLOS class or a KnowledgeWorks structure class in which
case the initargs are the same as those for the automatically
defined constructor function of the structure.

Values Returns the new instance.

Examples (make-instance ’start)
(make-instance ’driver :location ’london
                      :kb-name ’fred)

See Also def-kb-class

def-kb-struct

def-named-kb-class

-mea Conflict Resolution Tactic / Function

Syntax -mea instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic -

mea, otherwise nil . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Values A single value, either nil  or non-nil .



Examples (defcontext my-context1 :strategy (-mea))
(defcontext my-context2 :strategy (priority -mea))

See Also defcontext

deftactic

mea

instantiation

conflict-set

fire-rule

mea Conflict Resolution Tactic / Function

Syntax mea instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic mea,
otherwise nil . The function is intended to be used primarily
by including it in the conflict resolution strategy for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (mea))
(defcontext my-context2 :strategy (priority mea))

See Also defcontext

deftactic

-mea

instantiation

conflict-set

fire-rule
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named-kb-object Class

Description This class is the mixin class for named KnowledgeWorks
CLOS objects.

Examples (defclass driver (named-kb-object)
  ((location) (allocated-truck)))

See Also get-kb-object

kb-name

def-named-kb-class

no-debug Function

Syntax no-debug

Arguments None.

Description Turns off all KnowledgeWorks debugging facilities. This
means that rules and contexts cannot be single stepped or
monitored, and no record is kept of when objects are created
or modified. Execution speed of the rulebase is improved,
and memory requirements reduced.

Values nil

Examples (no-debug)

See Also all-debug

not Backward Chaining Goal

Syntax not { condition}*



Arguments condition may be any backward chaining goal. If not  is used
in a forward chaining pre-condition, condition may only con-
tain expressions normally allowed in forward chaining pre-
conditions (object base references and lisp tests).

Description The not  goal succeeds if the conditions contained within fail.

Examples (not (truck ?truck driver ?driver) (test ?driver))

See Also test

-order Conflict Resolution Tactic / Function

Syntax -order instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic -

order , otherwise nil . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (-order))
(defcontext my-context2 :strategy (priority -order))

See Also defcontext

deftactic

order

instantiation

conflict-set

fire-rule
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order Conflict Resolution Tactic / Function

Syntax order instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic
order , otherwise nil . The function is intended to be used pri-
marily by including it in the conflict resolution strategy for a
context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (order))
(defcontext my-context2 :strategy (priority order))

See Also defcontext

deftactic

-order

instantiation

conflict-set

fire-rule

*print-verbose* Variable

Description Normally objects in KnowledgeWorks are printed out in a
brief form similar to ordinary CLOS objects. If this variable is
set to t  then all the slots and slot values are shown in its
printed representation. Note that circularities cannot be
detected.

Initial Value nil



-priority Conflict Resolution Tactic / Function

Syntax -priority instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic -

priority , otherwise nil . The function is intended to be used
primarily by including it in the conflict resolution strategy
for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (-priority))
(defcontext my-context2 :strategy (recency -priority))

See Also defcontext

deftactic

priority

instantiation

conflict-set

fire-rule

priority Conflict Resolution Tactic / Function

Syntax priority instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.
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Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic
priority , otherwise nil . The function is intended to be used
primarily by including it in the conflict resolution strategy
for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (priority))
(defcontext my-context2 :strategy (recency priority))

See Also defcontext

deftactic

-priority

instantiation

conflict-set

fire-rule

-recency Conflict Resolution Tactic / Function

Syntax recency instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic
recency , otherwise nil . The function is intended to be used
primarily by including it in the conflict resolution strategy
for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (recency))
(defcontext my-context2 :strategy (priority recency))



See Also defcontext

deftactic

recency

instantiation

conflict-set

fire-rule

recency Conflict Resolution Tactic / Function

Syntax recency instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic
recency , otherwise nil . The function is intended to be used
primarily by including it in the conflict resolution strategy
for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (recency))
(defcontext my-context2 :strategy (priority recency))

See Also defcontext

deftactic

-recency

instantiation

conflict-set

fire-rule
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reset Function

Syntax reset

Arguments None.

Description Clears all KnowledgeWorks objects (both KnowledgeWorks
CLOS objects and KnowledgeWorks structures). The list of
KnowledgeWorks classes remains unaffected.

Values nil

Examples (reset)

See Also clear-all

clear-rules

return Backward Chaining Goal

Syntax return

Arguments None.

Description Takes the topmost context on the agenda and makes it the
current context, discarding the previous current context.
When called from within a rule, rule execution continues to
the end and the next rule to fire will be from the new current
context.

Examples (return)

See Also context



*signal-kb-name-clash* Special Variable

Syntax *signal-kb-name-clash*

Arguments None.

Description: Determines behaviour when creating a new named KB object
with the same name as an existing KB object.

The possible values are:

:error Signals a error Continuing will replace the
old object with the new object.

:warn Signals a warning and replaces the old
object with the new object.

:quiet Replaces the old object with the new object.

The default value is :error .

-specificity Conflict Resolution Tactic / Function

Syntax -specificity instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic -

specificity , otherwise nil . The function is intended to be
used primarily by including it in the conflict resolution strat-
egy for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (-specificity))
(defcontext my-context2
    :strategy (priority -specificity))
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See Also defcontext

deftactic

specificity

instantiation

conflict-set

fire-rule

specificity Conflict Resolution Tactic / Function

Syntax specificity instantiation1 instantiation2

Arguments instantiation1 and instantiation2 are both instantiation objects.

Description The function returns non-nil  if and only if instantiation1 is
preferred to instantiation2 by the conflict resolution tactic
specificity , otherwise nil . The function is intended to be
used primarily by including it in the conflict resolution strat-
egy for a context.

Values A single value, either nil  or non-nil .

Examples (defcontext my-context1 :strategy (specificity))
(defcontext my-context2
  :strategy (priority specificity))

See Also defcontext

deftactic

-specificity

instantiation

conflict-set

fire-rule



standard-context Backward Chaining Goal

Syntax standard-context

Arguments None.

Description A built-in backward chaining goal which implements a meta-
interpreter for the default (normal) behaviour of a context. It
is as if defined by the rule

(defrule standard-context :backward
  ((standard-context)
   <--
   (start-cycle)
   (instantiation ?instantiation)
   (fire-rule ?instantiation)
   (cut)
   (standard-context)))

Examples (defcontext my-context1
  :meta (((format t "~%Entering context MY-CONTEXT1"))
         (standard-context)))

See Also defcontext

instantiation

start-cycle

fire-rule

standard-kb-object Class

Description This class is the mixin class for (unnamed) KnowledgeWorks
CLOS objects.

Examples (defclass driver (standard-kb-object)
  ((location) (allocated-truck)))
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See Also def-kb-class

start-cycle Backward Chaining Goal

Syntax start-cycle

Arguments None.

Description This backward chaining goal is only relevant when writing a
meta-interpreter for a context. This goal must be called at the
start of every forward chaining cycle as it performs some
essential housekeeping.

Example (start-cycle)

See Also defcontext

instantiation

standard-context

fire-rule

start-kw Function

Syntax start-kw &key hostname

Arguments hostname is a string which specifies a display of some
machine.

Description Starts the KnowledgeWorks programming environment from
the initial prompt when the KnowledgeWorks image is
started. The environment is displayed on the machine speci-
fied by hostname, defaulting to the machine on which the
KnowledgeWorks image is running.

Values None.



Examples (start-kw)
(start-kw :hostname "machine1:0")

See Also start-kw-icon

start-kw-icon Function

Syntax start-kw-icon

Arguments None.

Description Once the KnowledgeWorks or LispWorks programming
environment has been started, start-kw-icon  brings up
another KnowledgeWorks top level window.

Examples (start-kw-icon)

See Also start-kw

test Backward Chaining Goal

Syntax test lisp-form

Arguments lisp-form is a single lisp form.

Description Succeeds if and only if the lisp-form returns a non-nil  value.
Any currently bound variables may be used in the lisp form.

Examples (test (> ?c 10))
(test (not (and  (eq ?a ?b) (member ?b ?c))))

undefcontext Macro

Syntax undefcontext context-name &rest ignore
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Arguments context-name is a symbol which names a context. ignore is
ignored. It is provided so that "un" may be prepended to a
context definition in an editor buffer and evaluated to
remove the context.

Description Removes the named context and all the rules in it.

Examples (undefcontext my-context)

See Also defcontext

undefrule Macro

Syntax undefrule rule-name &rest ignore

Arguments rule-name is a symbol which names a rule. ignore is ignored. It
is provided for convenience so the "un" may be prepended to
a rule definition in an editor buffer and evaluated to remove
the rule.

Description Removes the named rule.

Examples (undefrule my-rule1)

See Also defrule

with-rule-actions Macro

Syntax with-rule-actions bound-variables &body body

Arguments bound-variables is a list of variables (each starting with ?)
which are already bound. body is a rule body consisting of the
same kind of statements that make up the right hand side of
a forward or backward chaining rule.



Description This macro enables rule syntax to be embedded within Lisp.
The body is executed just as if it were the right hand side of a
rule. All variables in the body (denoted by ?) are taken to be
unbound unless found in the list bound-variables in which
case its value is taken from the Lisp variable of the same
name. It is similar to the function any  but can be compiled for
efficiency.

Values T if the body succeeds (that is, all statements are successfully
executed), else nil  (if the statements fail).

Example (defun my-fn (?x)
  "prints all the lists which append to give ?x and
   then returns NIL"
  (with-rule-actions (?x)
    (append ?a ?b ?x)
    ((format t "~%~S and ~S append to give ~S"
             ?a ?b ?x))
    (fail)))

See Also any
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Appendix A

ACommon Prolog
A.1  Introduction

A.1.1  Overview

Common Prolog is a logic programming system within Common Lisp. It con-
forms closely to Edinburgh Prolog and at the same time integrates well with
Lisp. The basic syntax of Common Prolog is Lisp-like, but an Edinburgh
syntax translator is included that provides the ability to use pre-existing code.
The implementation of Common Prolog was motivated by the desire to use
the logic programming paradigm without having to give up the advantages of
a Lisp development environment. Common Prolog is tightly integrated with
Lisp and can be easily used in a mixed fashion with Lisp definitions even
within the same source file. Common Prolog predicates are compiled into Lisp
functions which may then be compiled by a standard Lisp compiler. Substan-
tial effort has gone into providing a powerful debugging environment for
Common Prolog, so that it can be used when building serious applications.
The implementation of Common Prolog is based loosely on the Warren
Abstract Machine (WAM) modified to take advantage of a Lisp environment’s
built in support for control flow and memory allocation. (For more details of
the WAM, see An Abstract Prolog Instruction Set, by David H D Warren, Techni-
cal Note 309, SRI International, October 1983.)
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A.1.1.1  Starting Common Prolog

Common Prolog may be loaded into an image with the function call:

(lw:initialize-prolog)

This will demand load the entire Common Prolog system. If Common Prolog
will be used extensively, it may be worthwhile to save an image with it
installed. Alternatively, one may simply wish to insert the call to
lw:initialize-prolog  into your .lispworks  file.

A.2  Syntax
Common Prolog uses a Lisp-like syntax in which variables are prefixed with
“?” and normal Lisp prefix notation is used. Goals are represented as either
lists or simple vectors e.g. (reverse (1 2 3) ?x) or #(member ?x (1 2 3)) .
A symbol beginning with ? may be escaped by prefixing another ?.i.e. ?foo  is
the variable named foo ; ??foo  is the symbol ?foo .

The definition of append/3 from Prolog:

  append([], X, X).
  append([U|X], Y, [U|Z]) :-
          append(X, Y, Z)

translates to:

  (defrel append
    ((append () ?x ?x))
    ((append (?u . ?x) ?y (?u . ?z))
     (append ?x ?y ?z)))

Unlike many Lisp-based logic systems, Common Prolog uses simple vectors
to represent Prolog structured terms. Thus, functor , arg , and =..  all behave
in a standard fashion:

(arg 2 (foo 3 4) (3 4))
(arg 2 #(foo 3 4) 4)
(functor (foo 3 4) \. 2)
(functor #(foo 3 4) foo 2)
(=.. #(foo 3 4) (foo 3 4))
(=.. (foo 3 4) (\. foo (3 4)))



A.3 Defining Relations
A.3  Defining Relations
The normal method of defining relations in Common Prolog is to use the
defrel  macro:

(defrel < relation name>
  [(declare declaration*)]
    < clause1>
     .
     .
    < clauseN>)

where each <clause> is of the form:

(< clause head>
 < subgoal1>
    .
    .
 < subgoalN>)

and declarations may include: (mode arg-mode*)  and any of the normal Lisp
optimization declarations. Mode declarations determine how much clause
indexing will be done on the predicate and can also streamline generated code
for a predicate that will only be used in certain ways. A mode declaration con-
sists of the word “MODE” followed by a mode spec for each argument posi-
tion of the predicate. The possible argument mode specs are:

? Generate completely general code for this arg and don’t
index on it.

?* Generate completely general code and index.

+ Generate code assuming this argument will be bound
on entry and index.

- Generate code assuming this argument will be
unbound on entry and don’t index.

The default mode specs are ?*  for the first argument and ? for all the rest.
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A.4  Using The Logic Interpreter
The Common Prolog system comes with a built-in read-query-print  loop
similar to a Prolog interpreter loop. To run it, make sure the common-prolog
package is accessible and type: (rqp) . You will be presented with the prompt:
==> . At this point you may type in goal expressions e.g:

|==> (append ?x ?y (1 2))
|
|?X = NIL
|?Y = (1 2)

Now Common Prolog is waiting for you to indicate whether or not you wish
more solutions. If you hit Return, you will get the message OK and return to
the top level:

|?X = NIL
|?Y = (1 2)<RETURN>
|
|OK.
|
|==>

A.4.1  Multiple Solutions

If you hit ;  (semicolon) following the retrieval of a solution, the system will
attempt to resatisfy your goal:

|?X = NIL
|?Y = (1 2);
|
|?X = (1)
|?Y = (2);
|
|?X = (1 2)
|?Y = NIL;
|
|NO.
|
|==>

When no more solutions remain, NO. is displayed and you are back at the top
level.
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A.4.2  Multiple Goals

To request the solution of multiple goals, use: (and < goal1> ... < goalN>)

For example:

|==> (and (member ?x (2 3)) (append (?x) (foo) ?y))
|
|X = 2
|Y = (2 FOO)
|
|OK.
|
|==>

A.4.3  Definitions

It is possible to type logic definitions directly into the interpreter. The result-
ing Lisp code will be compiled in memory and you may use the definition
immediately, for example.:

|==> (defrel color
|      ((color red))
|      ((color blue))
|      ((color green)))
|
|<... various compilation messages ...>
|
|YES.
|OK.
|
|==> (color ?x)
|
|?X = RED

A.4.4  Exiting the Interpreter

The Common Prolog interpreter may be exited by typing:

|==> (halt)
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A.5  Accessing Lisp From Common Prolog
It is apparent from the Common Prolog syntax that the first element of any
valid goal expression must be a symbol. Common Prolog takes advantage of
this fact and gives a special interpretation to a goal with a list in the first posi-
tion. A list in the car  of a goal is treated as a Lisp expression with normal Lisp
evaluation rules. Any logic variables in the expression are instantiated with
their values. (They must be bound). The rest of the goal expression should be
a list of expressions to be unified with the values returned by the Lisp evalua-
tion. Any extra values returned are ignored, and any extra expressions in the
tail of a goal are unified with new unbound variables.

A.5.1  Examples

|==> ((print "foo"))
|
|"foo"
|YES.
|
|==> (and (= ?x 3) ((* ?x ?x) ?y))
                 ; Note that "?y" is unified with 9

|?X = 3
|?Y = 9
|
|==> ((* 3 3) 10)

|NO.
|
|==> ((floor 3 4) ?x ?y)
|
|?X = 0
|?Y = 3

|==> ((floor 3 4) ?x)
|
|?X = 0
|
|==> ((* 3 4) ?x ?y)
|
|?X = 12
|?Y = ?0
  ; note that system generated variables look like:
  ; ?<integer>
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|==> ((typep 3 ’integer) ?x)
|
|?X = T
|
|==> ((typep 3 ’integer) t)
|
|YES.
|
|==> (and ((floor 5 3) ?x) ((floor 4 3) ?x))
|
|?X = 1
|
|==> ((cons 3 4) (?x . ?y))
|
|?X = 3
|?Y = 4
|
|==> (and (= ?op *) ((list ?op 3 4) ?y) (call (?y ?z)))
|
|?OP = *
|?Y = (* 3 4)
|?Z = 12
|
|==> (and (defrel fact
|           ((fact 0 1))
|           ((fact ?x ?y)
|            ((- ?x 1) ?w)
|            (fact ?w ?z)
|            ((* ?z ?x) ?y)))
|         (fact 10 ?result))
|
|?X = ?0
|?Y = ?1
|?W = ?2
|?Z = ?3
|?RESULT = 3628800

A.6  Calling Prolog From Lisp
There are several entry points provided for calling Prolog from Lisp. The main
interface function is called logic  and has numerous options. The basic form
is:
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(logic < goal>
       :return-type < return-type>
       :all < all-type>
       :bag-exp < bag-exp>)

The keyword arguments are interpreted as follows:

:return-type  describes what to do with a solution when one is found. Possi-
ble values of :return-type  are:

:display Display variable bindings and prompt user (the option
used by the read-query-print  loop).

:fill Instantiate the goal expression and return it.

:bag Instantiate <bag-exp> and return it.

:alist Return an alist of variables and bindings.

The default is :fill .

:all  tells what to do with multiple solutions. Possible values of :all  are:

nil Return the first solution.

:values Return multiple solutions as multiple values.

:list Return a list of the solutions.

:bag-exp  is an expression that should be instantiated with the bindings from
a solution. This is only meaningful if :return-type  is :bag .

A.6.1  Examples

(logic ’(color ?x) :return-type :display)

writes:

?X = RED<wait for input>

(logic ’(color ?x) :return-type :fill)

returns:
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(COLOR RED)
T

(logic ’(color ?x) :return-type :alist)

returns:

((?X . RED))
T

(logic ’(color ?x) :all :list)

returns:

((COLOR RED) (COLOR BLUE) (COLOR GREEN))
T

(logic ’(color ?x)
       :return-type :bag
       :bag-exp ’(?x is a color)
       :all :values)

returns:

(RED IS A COLOR)
(BLUE IS A COLOR)
(GREEN IS A COLOR)

A.6.2  Interface Functions

Three simple interface functions call logic . They are ANY, FINDALL , and FIND-

ALLSET. Each takes two arguments: a result expression to instantiate and a
goal expression. ANY returns the first solution found. FINDALL  returns all solu-
tions. FINDALLSET returns all solutions deleting duplicates.

A.6.2.1  Examples

Assuming the definitions for fact  and color  from the previous examples.

|(any ’(?x is the factorial of 5) ’(fact 5 ?x))

 returns:

|
|(120 IS THE FACTORIAL OF 5)
|
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|(findall ’(?x is a color) ’(color ?x))

returns:

|
|((RED IS A COLOR) (BLUE IS A COLOR)
  (GREEN IS A COLOR))
|

|(findall ’?y ’(or (= ?y 5) (= ?y 5)))

returns:

|
|(5 5)
|
|(findallset ’?y ’(or (= ?y 5) (= ?y 5))) returns:
|
|(5)

FINDALL  and FINDALLSET will hang if a goal expression generates an infinite
solution set.

More powerful all solution predicates (BAGOF and SETOF) are available from
within Common Prolog.

A different interface is available for predicates which will be called often from
Lisp. The macro deflogun  may be used to generate normal Lisp functions that
run with precompiled goals.

A.6.2.2  Example

(deflogfun break-up (y) (append ?a ?b y) (?a ?b))

then:

(break-up ’(foo bar baz)

returns:

(NIL (FOO BAR BAZ))
T

(break-up ’(foo bar baz) :all :values)

returns:
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(NIL (FOO BAR BAZ))
((FOO) (BAR BAZ))
((FOO BAR) (BAZ))
((FOO BAR BAZ) NIL)

(break-up ’(foo bar baz) :all :list)

returns:

((NIL (FOO BAR BAZ))
 ((FOO) (BAR BAZ))
 ((FOO BAR) (BAZ))
 ((FOO BAR BAZ) NIL))
T

A final interface mechanism is with-prolog. With-prolog allows one to
embed prolog into an arbitrary lisp function. Lisp variables are referenced in
Prolog using “?.< name>”.

A.6.2.3  Example

(defun palindromep (x)
  (with-prolog
    (append ?a (?b . ?c) ?.x) ; note "?.x" reference
    (or (reverse ?a ?c)
        (reverse ?a (?b . ?c)))))

(palindromep ’(yes no maybe))

returns:

NIL

(palindromep ’(yes no maybe no yes)

returns:

T

The body of a with-prolog returns t  if it succeeds and a non-local exit is not
executed. It returns nil on failure.
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A.7  Debugging
Common Prolog provides a standard 4-port debugging model (call exit

redo fail ). Tracing, Spy Points, Leashing, and interactive debugging will
each be discussed separately.

A.7.1  Tracing

Exhaustive tracing is available with Common Prolog through the use of:
(trace) . After executing (trace) , all goals will be displayed until control is
returned to the top level loop, nodebug  is executed or notrace  is executed.

A.7.2  Spy Points

Spy points are the most important debugging facility in Common Prolog.
They are used in the same way trace  is used in Lisp. After executing (spy

foo) , all events associated with satisfying foo  goals will be traced and the
user will enter a debugging command loop at every port (see <Empha-
sis>Interactive Debugging below). A user can also specify (spy (foo 3)) ,
(spy (foo bar)) , or (spy ((foo 3) bar))  to place spy points on foo  goals
with arity 3, on all predicates for foo  and bar , or on foo  with arity 3 and all
predicates for bar  respectively. Spy points are turned off with (nospy < spy-
points>) . If no spy points are mentioned, nospy  will turn off all spy points.

A.7.3  Leashing

Leashing allows the user to control execution while tracing for goals that are
not spied. Spied goals cause execution to enter a debugging command loop
whenever they are reached. Leashing provides the same functionality for
unspied goals. A user may choose to enter a debugging command loop at any
subset of ports by using (leash < events>)  where events may be: call, redo, exit,
fail. Leashing may be turned off using (unleash) .

A.7.4   Interactive Debugging

When Common Prolog execution enters a debugging command loop, the user
has many options, which may be listed with ?, for example:
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|==> (spy member)
|
|((MEMBER 2))
|YES.
|OK.
|
|==> (member 3 ?x)
|
|[1] CALL: (MEMBER 3 ?0)? ? <- user types ?
|
|(c)reep     - turn on exhaustive tracing
|(s)kip      - skip until another port is
|              reached for this goal
|(l)eap      - turn off tracing until a spy
|              point or this goal is reached
|(b)reak     - enter a recursive
|              read/query/print loop
|(d)isplay   - display a listing for the
|              current goal
|(q)uit      - quit to top level
|(r)etry     - try to satisfy this goal again
|(f)ail      - cause the current goal to fail
|(a)bort     - exit Common Prolog
|?           - display this information
|
|?
|
|In a little more detail...
|
|creep   - causes exhaustive tracing of the
|          next goal
|skip    - ignores spy points and executes
|          without displaying anything until
|          this goal is reached again
|          either at an exit, fail,
|          or redo port
|leap    - turns off exhaustive tracing until
|          a spy point or this goal is
|          reached
|break   - enters a recursive interpreter loop
|          so that the user may query
|          values, redefine a predicate, etc.
|display - uses "listing" to display the
|          listing of the current goal
|quit    - returns to the top level interpreter
|         loop
|retry   - causes execution to return to the
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|          call port of this goal as if
|           this goal had just been reached for
|          the first time.
|fail    - causes execution to jump to the fail
|         port of this goal
|abort   - completely exit Common Prolog

Continuing the example:

|d <- user selects display
|
|Compiled procedure:
|
|(DEFREL MEMBER
|  ((MEMBER ?X (?X . ?)))
|  ((MEMBER ?X (? . ?Y)) (MEMBER ?X ?Y))) ? c
|  ...user selects creep

|[1] EXIT: (MEMBER 3 (3 . ?0))? r
|  ...user selects retry
|
|[1] CALL: (MEMBER 3 ?0)? f <-user selects fail
|
|[1] FAIL: (MEMBER 3 ?0)? r <- one more time
|
|[1] CALL: (MEMBER 3 ?0)? s <- skip
|
|[1] EXIT: (MEMBER 3 (3 . ?0))? l <- leap

|?X = (3 . ?0); <- more solutions
|
|[1] REDO: (MEMBER 3 (3 . ?0))? c <- creep
|
|[2] CALL: (MEMBER 3 ?0)? b <- break
|
|
|==> (nospy)
|
|NIL <- current spylist
|YES.
|OK.
|
|==> (halt) <- return to original execution
|? l <- leap
|
|?X = (?0 3 . ?1)<cr>
|
|OK.
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Another example:

|==> (defrel reverse
|      ((reverse () ()))
|      ((reverse (?x . ?y) ?z)
|       (reverse ?y ?w)
|       (append ?w (?x) ?z)))
|<noise..>
|
|?X = ?0
|?Y = ?1
|?Z = ?2
|?W = ?3
|
|OK.

|==> (defrel append
|      ((append () ?x ?x))
|      ((append (?u . ?x) ?y (?u . ?z))
|       (append ?x ?y ?z)))
|<noise..>

|?X = ?0
|?U = ?1
|?Y = ?2
|?Z = ?3
|
|OK.

|==> (unleash)
|
|YES.
|OK.
|
|==> (trace)
|
|YES.
|OK.
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|==> (reverse (1 2 3) ?x)
|
|[1] CALL: (REVERSE (1 2 3) ?0)
|[2] CALL: (REVERSE (2 3) ?0)
|[3] CALL: (REVERSE (3) ?0)
|[4] CALL: (REVERSE NIL ?0)
|[4] EXIT: (REVERSE NIL NIL)
|[5] CALL: (APPEND NIL (3) ?0)
|[5] EXIT: (APPEND NIL (3) (3))
|[3] EXIT: (REVERSE (3) (3))
|[6] CALL: (APPEND (3) (2) ?0)
|[7] CALL: (APPEND NIL (2) ?0)
|[7] EXIT: (APPEND NIL (2) (2))
|[6] EXIT: (APPEND (3) (2) (3 2))
|[2] EXIT: (REVERSE (2 3) (3 2))
|[8] CALL: (APPEND (3 2) (1) ?0)
|[9] CALL: (APPEND (2) (1) ?0)
|[10] CALL: (APPEND NIL (1) ?0)
|[10] EXIT: (APPEND NIL (1) (1))
|[9] EXIT: (APPEND (2) (1) (2 1))
|[8] EXIT: (APPEND (3 2) (1) (3 2 1))
|[1] EXIT: (REVERSE (1 2 3) (3 2 1))
|?X = (3 2 1);

|[1] REDO: (REVERSE (1 2 3) (3 2 1))
|[8] REDO: (APPEND (3 2) (1) (3 2 1))
|[9] REDO: (APPEND (2) (1) (2 1))
|[10] REDO: (APPEND NIL (1) (1))
|[10] FAIL: (APPEND NIL (1) ?0)
|[9] FAIL: (APPEND (2) (1) ?0)
|[8] FAIL: (APPEND (3 2) (1) ?0)
|[2] REDO: (REVERSE (2 3) (3 2))
|[6] REDO: (APPEND (3) (2) (3 2))
|[7] REDO: (APPEND NIL (2) (2))
|[7] FAIL: (APPEND NIL (2) ?0)
|[6] FAIL: (APPEND (3) (2) ?0)
|[3] REDO: (REVERSE (3) (3))
|[5] REDO: (APPEND NIL (3) (3))
|[5] FAIL: (APPEND NIL (3) ?0)
|[4] REDO: (REVERSE NIL NIL)
|[4] FAIL: (REVERSE NIL ?0)
|[3] FAIL: (REVERSE (3) ?0)
|[2] FAIL: (REVERSE (2 3) ?0)
|[1] FAIL: (REVERSE (1 2 3) ?0)
|NO.
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A.8  Common Prolog Macros
Macros may be defined within the logic system using the form:

(defrelmacro < name> < arg-list> < body>)

which is effectively the same as a Common Lisp defmacro . Logic macros are
expanded before variable translation so that logic variables may be treated as
atoms. defrelmacro  forms must have a fixed number of arguments. This
allows different predicates with the same name but different aritys to be
defined. If you want to define a special form with an arbitrary number of
arguments, use defrel-special-form-macro .

A.8.1  Example

(defrelmacro append3 (x y z w)
  (let ((iv (make-internal-var)))
  ‘(and (append ,x ,y ,iv)
        (append ,iv ,z ,w))))

==> (append3 (1) (2) (3) ?y)

?Y = (1 2 3)

A.9  Edinburgh Syntax
Common Prolog provides a translator from Edinburgh syntax to allow users
to port pre-existing code. consult  and reconsult  behave as expected while
compile- and-reconsult compiles a file and reconsults the result.   Loading of a
compiled file is equivalent to reconsult . Edinburgh syntax may also be used
to interact with Common Prolog through the use of a different read-query-
print loop. To use Edinburgh syntax, use (erqp)  instead of (rqp)  to start your
command loop.

A.10  Graphic Development Environment
Common Prolog includes a graphic environment for users with bitmap dis-
plays. The environment consists of a specialized listener and graphic debug-
ging tools. With the debugging tools it is possible to step through a program
at the source level and control the 4-port debugger using the mouse. Call trees
for predicates may also be displayed and manipulated.
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The specialized listener provides mouse control over:

• File editing, compiling, consulting and reconsulting

•  Debugging control flow (creep, leap, skip, etc.)

•  Leashing of debugging ports

• The addition and deletion of spy points.

The Logic Listener interaction is similar to a normal Lisp Listener and will
accept normal Lisp expressions except that:

1.  Any expression that can be interpreted as Common Prolog will be han-
dled by the Logic subsystem.

2. Any line beginning with ‘?-’ is read as Edinburgh syntax.

3. If a line consisting of just ‘?-’ is entered, the Logic Listener will go into an
Edinburgh (erqp)  loop.
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A.11  Built-in Predicates

/== (?x ?y) same as Prolog \==

= (?x ?y) standard Prolog

=.. (?x ?y) standard Prolog

== (?x ?y) standard Prolog

@< (?x ?y) same as Prolog except all variables
sort as identical

@=< (?x ?y) ditto

@> (?x ?y ditto

@>= (?x ?y) ditto

append (?x ?y ?z) standard Prolog

arg (+index +term ?value) standard Prolog

asserta (+exp) standard Prolog

assertz (+exp) standard Prolog

atomic (?x) standard Prolog

bagof (?exp
       (+goal . +ex-vars)
       ?bag)

standard Prolog (unusual syntax)*

call (+exp) standard Prolog

clause (+head ?tail) standard Prolog

debug () cause debugging information to be
saved for each call whether it is
spied or not

debugging () display a list of all spied goals

defdetrel
  (+name &rest +clauses)

define a relation and declare it to be
deterministic

defgrammar
  (+name &rest +rules)

define a grammar rule

defrel
  (+name &rest +clauses)

define a relation

defrelmacro
  (+name +args &rest
+body)

 define a logic macro
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defrel-special-form-
macro
  (+name +args &rest
+body)

like defrelmacro but can have
&rest in +args . Use of this form
will shadow all predicates named
+name regardless of arity.

deterministic (+name) declare the relation called ?name to
be deterministic

erase (+ref) delete the predicate with database
reference ?ref  from the database

fail () standard Prolog

findall
  (?exp +goal ?result)

generate all solutions to ?goal and
instantiate ?exp  with the values.
Return a list in ?result .

findallset
  (?exp +goal ?result)

same as findall/3 but removes dupli-
cates

functor
  (?term ?functor ?arity)

standard Prolog

halt () exit Common Prolog

integer (?x) standard Prolog

is (?result +exp) standard Prolog

keysort (+in ?out) standard Prolog except uses alist
style cons pairs

leash (+event-spec) cause the interpreter to pause and
ask for input when one of the
leashed events is traced. An event-
spec is one of: (call exit redo fail),
or a list of ports.

listing
  (+name &optional
+arity)

display a listing of the named predi-
cate or listings for each arity if no
arity is specified

member (?x ?y) standard Prolog

nodebug () leave debug mode (cease saving
debug info for non-spied goals)

nonvar (?x) standard Prolog

nospy (+args) remove +args  from the list of spied
goals. +args may be a predicate
name or a list of predicate names.
Unspy all goals if +args  is nil

not (+x) standard Prolog
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notrace () turn off exhaustive tracing for
debugged goals

once (+exp) satisfy +exp  as a goal once, then
fail on retrying even if +exp  has
more solutions: this can be used to
make a call deterministic so that the
compiler can perform last call optimi-
zation

output-defrels
  (+name ?defrels)

return a list of defrel  expressions
derived from the dynamic clauses
associated with ?name

read-term (?term) read in a term

recorda (+exp ?val ?ref) standard Prolog

recorded (+term ?val
?ref)

standard Prolog

recordz (+exp ?val ?ref) standard Prolog

repeat () standard Prolog

retract (+clause) standard Prolog

setof (?exp
       (+goal . +ex-vars)
       ?bag)

standard Prolog (unusual syntax)*

sort (+in ?out) standard Prolog

spy (+args)  spy +args . +args may be a pred-
icate name or a list of predicate
names. If arity is not mentioned for a
predicate name, predicates of all
aritys with that  name are spied.

trace () turn on tracing for debugged goals,
also turn on debugging for the next
top level goal

translate-vars
  (?intern ?extern)

translate back and forth between
internal and external variable repre-
sentations. Can be used to pretty up
the writing of terms containing vari-
ables
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* setof  and bagof  in standard Prolog use a special syntax for existentially
quantified variables, for example:

?- setof(X, Y^foo(X,Y), Z).

In Common Prolog, this would look like:

==> (setof ?x ((foo ?x ?y) ?y) ?z)

So, a goal with no existentially quantified variables is nested in an extra set of
parentheses:

==> (bagof ?x ((bar ?x)) ?z)

A.12  Adding Built-in Predicates
Common Prolog provides several special forms for adding new predicates
written in Lisp. Each one is described below, with an example.

(defdetpred < name> < num args> < body>)

Defines a simple predicate that just runs lisp code and doesn’t have to unify
any variables. Arguments are referenced with: (special-arg <argnum>) .
Succeeds by default. If a failure case arises, use: (detpred-fail <name>
<num args>) .

(defdetpred integer 1
  (unless (integerp (special-arg 0))
    (go fail)))

(defdetunipred < name> < num args> < unifier1 unifier2>
              < aux-vars> < body>)

true () standard Prolog

unleash (+event-spec) Undo leashing for +event-spec.
+event-spec may be a port or a list
of ports. If +event-spec is nil, all
ports are unleashed.

var (?x) standard Prolog



A.13 Edinburgh Compatibility Predicates
defdetunipred  is used when the defined predicate needs to unify values with
arguments (or unify in general). The body is executed and, if successful, (that
is, detpred-fail  has not been called) unification is performed on the two uni-
fiers. (If more than two items need to be unified, cons up lists of items to
unify).

(defdetunipred arg 3 (temp1 temp2)
         (temp1 temp2 index term value)
         (setf index (special-arg 0)
               term (special-arg 1)
               value (special-arg 2))
         (unless (and (numberp index)
                      (plusp index)
                      (or (and (term-p term)
                               (< index (length term)))
                          (and (consp term)
                               (< index 3))))
                 (detpred-fail arg 3))
         (if (consp term)
             (setf temp1 (if (= index 1)
                             (car term)
                             (cdr term)))
            (setf temp1 (term-ref term index)))
         (setf temp2 value))

A.13  Edinburgh Compatibility Predicates
The following predicates all have their standard Edinburgh definitions:
139



Appendix A Common Prolog

140
-->
->
/
//
<<
=
=
=<
>>
?-
@<
@>
@>=
\,
\.
\:-
\:=
\;
\\
\\
\\+
\\/
\\=
\\==
^
current-op
display
get
get0
is
name
nl
put
see
seeing
seen
skip
tell
telling
told
ttynl
ttyput
write
writeq
|is|



Appendix B

BExamples
B.1  The Tutorial
The code for the tutorial (Chapter 2, “Tutorial”) is reproduced for easy refer-
ence.

; -*-mode : lisp ; package : kw-user -*-

(in-package kw-user)

;;; ---------------- OBJECT DEFINITIONS ------------

(def-kb-class node ()
   ((animal :initform nil :accessor node-animal
            :initarg :animal)
    (question :initform nil :accessor node-question
              :initarg :question)
    (yes-node :initform nil :accessor node-yes-node
              :initarg :yes-node)
    (no-node :initform nil :accessor node-no-node
             :initarg :no-node)))

(def-kb-class root ()
   ((node :initform nil :accessor root-node
          :initarg :node)))

(def-kb-struct current-node node)
(def-kb-struct game-over node animal answer)

;;; -------------- FORWARD CHAINING RULES -------------
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;;; if there is no question we are about to ask then
;;; ask the question which is the root question of the
;;; question tree

(defrule play :forward
  (root ?r node ?node)
  (not (current-node ? node ?))
  -->
  ((tk:send-a-message
     (format nil "  ANIMAL GUESSING GAME - ~
          think of an animal to continue")))
  (assert (current-node ? node ?node)))
;;; ask a yes/no question - these are non-leaf questions

(defrule y-n-question :forward
  (current-node ?current node ?node)
  (node ?node animal nil question ?q yes-node ?y-n
    no-node ?n-n)
  -->
  ((tk:confirm-yes-or-no ?q) ?answer)
  (erase ?current)
  ((find-new-node ?answer ?y-n ?n-n) ?new-current)
  (assert (current-node ? node ?new-current)))

(defun find-new-node (answer yes-node no-node)
  (if answer yes-node no-node))

;;; ask an animal question - these a leaf questions

(defrule animal-question :forward
  (current-node ?current node ?node)
  (node ?node animal ?animal question nil)
  -->
  ((tk:confirm-yes-or-no
     (format nil "Is it a ~a?" ?animal)) ?answer)
  (erase ?current)
  (assert (game-over ? node ?node animal ?animal
    answer ?answer)))

;;; add new nodes to the tree for the new animal and
;;; the question that distinguishes it
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(defrule new-question :forward
  :priority 20
  (game-over ? node ?node animal ?animal answer nil)
  -->
  (fetch-new-animal ?new-animal)
  ((tk:popup-prompt-for-string
    (format nil "Tell me a question for which the ~
           answer is yes for a ~a and no for a ~a"
           ?new-animal ?animal)) ?question)
  (assert (node ?yes-node question nil
           animal ?new-animal))
  (assert (node ?no-node question nil animal ?animal))
  (assert (node ?node animal nil yes-node ?yes-node
           no-node ?no-node question ?question)))

;;; game is over

(defrule game-finished :forward
  :priority 15
  (game-over ?g)
  -->
  (erase ?g)
;  (test (not (tk:confirm-yes-or-no "Play again?")))
  (return))

;;; --------------- BACKWARD CHAINING ----------------

;;; prompt user for new animal

(defrule fetch-new-animal :backward
   ((fetch-new-animal ?new-animal)
    <--
;    (repeat)
    ((string-upcase
       (tk:popup-prompt-for-string
                "What was your animal?"))
     ?new-animal)
    (not (= ?new-animal "NIL"))
                ; check if abort was pressed
    (or
     (doesnt-exist-already ?new-animal)
     (and ((tk:send-a-message "Animal exists already"))
          (fail)))))

;;; check if a node already refers to this animal
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(defrule doesnt-exist-already :backward
  ((doesnt-exist-already ?animal)
   <--
   (node ? animal ?animal)
   (cut)
   (fail))
  ((doesnt-exist-already ?animal)
   <-- ))

;;; --------------- SAVING THE ANIMAL BASE ------------

;;; writes out code which when loaded reconstructs the
;;; tree of questions

(defun save-animals (filename)
  (let* ((start-node (any ‘?node ‘(root ? node ?node)))
         (code ‘(make-instance ‘root
                 :node ,(node-code start-node)))
         (*print-pretty* t))
    (with-open-file
     (stream filename :direction :output
                      :if-exists :supersede)
      (write ‘(in-package kw-user) :stream stream)
      (write-char #\Newline stream)
      (write code :stream stream))
    nil))

(defun node-code (node)
  (when node
    ‘(make-instance ‘node
                   :question ,(node-question node)
       :animal ‘,(node-animal node)
       :yes-node ,(node-code (node-yes-node node))
       :no-node ,(node-code (node-no-node node)))))

B.2  Explanation Facility
Below is the complete code implementing the simple explanation facility of
Chapter 6, “A Simple Explanation Facility”. The implementation principle is
exactly as described.

 ;;; ---------- A SIMPLE EXPLANATION FACILITY ---------
(in-package kw-user)
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; connects rule to explanation definitions
(defvar *explanation-table*
                (make-hash-table :test #’eq))

; explanation generated at runtime
(defvar *explanation* nil)

;;; the next four definitions make up the defexplain
;;; macro for each of the why, what and because
;;; definitions we create a function which we can call
;;; at runtime on the bindings of the instantiation to
;;; generate the explanation text - this will be
;;; reasonably efficient

(defun is-var (expr)
  "is this a variable (i.e. starts with ?)"
  (and (symbolp expr)
    (eql (char (symbol-name expr) 0) #\?)))

(defun find-vars (expr)
  "returns a list of all the variables in expr"
  (if (consp expr)
      (append (find-vars (car expr))
              (find-vars (cdr expr)))
    (if (is-var expr) (list expr) nil)))

(defun make-explain-func (explain-stuff)
  "generates a function to generate explanation text at
   runtime"
  (let* ((explain-string (car explain-stuff))
         (explain-args (cdr explain-stuff))
         (vars (remove-duplicates
                 (find-vars explain-args))))
    ‘#’(lambda (bindings)
         (let ,(mapcar
                 #’(lambda (v)
                   ‘(,v (cdr (assoc ‘,v bindings))))
                 vars)
           (format nil ,explain-string ,
                   @explain-args)))))

(defmacro defexplain (rulename &key why what because)
  "puts an entry for the rule in the explanation table"
  ‘(setf (gethash ‘,rulename *explanation-table*)
         (list ,(make-explain-func why)
               ,(make-explain-func what)
               ,(make-explain-func because))))
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;;; next two definitions generate an explanation for
;;; each instantiation that fires and stores it away in
;;; *explanation*

(defun add-explanation (inst)
  "generate an explanation for firing this
   instantiation"
  (let ((explain-info
          (gethash (inst-rulename inst)
                   *explanation-table*)))
    (when explain-info
     (do-the-rest explain-info (inst-bindings inst)))))

(defun do-the-rest (explain-info bindings)
  "creates explanation text derived from explain
   functions and bindings"
  (let ((why-func (first explain-info))
        (what-func (second explain-info))
        (because-func (third explain-info)))
    (push ‘(,*cycle* ,(inst-rulename inst)
            ,(funcall why-func bindings)
            ,(funcall what-func bindings)
            ,(funcall because-func bindings))
          *explanation*)))))

;;; meta-interpreter for explanation contexts
;;; before firing the rule generate explanation for
;;; this cycle

(defrule explain-context :backward
  ((explain-context)
   <--
   (start-cycle)
   (instantiation ?inst)
   ((add-explanation ?inst))
   (fire-rule ?inst)
   (cut)
   (explain-context)))

;;; simple text output of the explanation

(defun explain (&optional cycle)
  "print out either the whole explanation or just for
   one cycle"
  (if cycle (explain-cycle (assoc cycle *explanation*))
    (dolist (cycle-entry (reverse *explanation*))
      (explain-cycle cycle-entry))))
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(defun explain-cycle (entry)
  "print this explanation entry"
  (if entry
      (let ((cycle (first entry))
            (rulename (second entry))
            (why (third entry))
            (what (fourth entry))
            (because (fifth entry)))
        (format t "~2%~a: ~a~%~a~%~a~%~a"
                cycle rulename why what because))
    (format t "~2%No explanation for this cycle")))

;;; we could make a really smart tool here, but to give
;;; the general idea...

(defun explain-an-action ()
  (let ((item
          (tk:scrollable-menu
            (reverse *explanation*)
            :title "Which action do you want
                    explained?"
            :name-function #’(lambda (x) (fourth x)))))
    (if item (tk:send-a-message (fifth item)))))

;;; starting the rule interpreter should clear any old
;;; explanation

(defadvice (infer rest-explanation :before)
    (&rest args)
  (unless *in-interpreter* (setq *explanation* nil)))

Below are some example rules using the explanation facility. They are taken
from the Monkey and Banana Example distributed with KnowledgeWorks.
The classes used in the example are monkey, object  and goal .

(defrule mb7 :forward
  :context mab
  (goal ?g status active type holds object ?w)
  (object ?o1 kb-name ?w at ?p on floor)
  (monkey ?m at ?p holds nil)
  -->
  ((format t "~%Grab ~s" ?w))
  (assert (monkey ?m holds ?w))
  (assert (goal ?g status satisfied)))
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(defexplain mb7
  :why ("Monkey is at the ~s which is on the floor" ?w)
  :what ("Monkey grabs the ~s" ?w)
  :because ("Monkey needs the ~s somewhere else" ?w))

(defrule mb12 :forward
  :context mab
  :context mab
  (goal ?g status active type walk-to object ?p)
  (monkey ?m on floor at ?c holds nil)
  (test (not (eq ?c ?p)))
  -->
  ((format t "~%Walk to ~s" ?p))
  (assert (monkey ?m at ?p))
  (assert (goal ?g status satisfied)))

(defexplain mb12
  :why ("Monkey is on the floor holding nothing")
  :what ("Monkey walks to ~s" ?p)
  :because ("Monkey needs to do something with an
             object at ~s" ?p))

(defrule mb13 :forward
  :context mab
  (goal ?g status active type walk-to object ?p)
  (monkey ?m on floor at ?c holds ?w)
  (test (and ?w (not (eq ?c ?p))))
  (object ?o1 kb-name ?w)
  -->
  ((format t "~%Walk to ~s" ?p))
  (assert (monkey ?m at ?p))
  (assert (object ?o1 at ?p))
  (assert (goal ?g status satisfied)))

(defexplain mb13
  :why ("Monkey is on the floor and is holding the ~s"
        ?w)
  :what ("Monkey walks to ~s with the ~s" ?p ?w)
  :because ("Monkey wants the ~s to be at ~s" ?w ?p))

(defrule mb14 :forward
  :context mab
  (goal ?g status active type on object floor)
  (monkey ?m on ?x)
  (test (not (eq ?x ‘floor)))
  -->
  ((format t "~%Jump onto the floor"))
  (assert (monkey ?m on floor))
  (assert (goal ?g status satisfied)))
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(defexplain mb14
  :why ("Monkey is on ~s" ?x)
  :what ("Monkey jumps onto the floor")
  :because ("Monkey needs to go somewhere"))

(defrule mb17 :forward
  :context mab
  (goal ?g status active type on object ?o)
  (object ?o1 kb-name ?o at ?p)
  (monkey ?m at ?p holds nil)
  -->
  ((format t "~%Climb onto ~s" ?o))
  (assert (monkey ?m on ?o))
  (assert (goal ?g status satisfied)))

(defexplain mb17
  :why ("Monkey is at the location of the ~s" ?o)
  :what ("Monkey climbs onto the ~s" ?o)
  :because ("Monkey wants to be on top of the ~s" ?o))

(defrule mb18 :forward
  :context mab
  (goal ?g status active type holds object nil)
  (monkey ?m holds ?x)
  (test ?x)
  -->
  ((format t "~%Drop ~s" ?x))
  (assert (monkey ?m holds nil))
  (assert (goal ?g status satisfied)))

(defexplain mb18
  :why ("Monkey is holding the ~s" ?x)
  :what ("Monkey drops the ~s" ?x)
  :because ("Monkey wants to do something for which he
             can’t hold anything"))

B.3  Uncertain Reasoning Facility
Below is the complete code which implements the uncertain reasoning facility
of Chapter 6, “Reasoning with Certainty Factors”. The implementation is
exactly as described with a few extra considerations to check the rule inter-
preter is running before returning an uncertain value, that the objects have a
certainty-factor slot and so on.

;;; -----SIMPLE REASONING WITH UNCERTAINTY FACTORS ----

(in-package kw-user)
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;;; default certainty factor
(defvar *c-factor* 1)

;;; implication strength of a rule
(defvar *implication-strength* 1)

(defun default-c-factor ()
  "if the forward chainer is not running, certainty
   factor is just 1"
  (if *in-interpreter*
      (* *implication-strength* *c-factor*)
    1))

;;; uncertain objects need a slot to store their
;;; ‘probability’ this slot defaults to the value
;;; returned by default-c-factor

(def-kb-class uncertain-kb-object ()
  ((c-factor :initform (default-c-factor)
             :initarg :c-factor)))

(defun object-c-factor (obj)
  "if an object has no uncertainty slot, return 1 (i.e.
   certain)"
  (if (slot-exists-p obj ‘c-factor)
      (slot-value obj ‘c-factor)
    1))

(defun inst-c-factor (inst)
  "the certainty factor of an instantiation"
  (token-c-factor (inst-token inst)))

(defun token-c-factor (token)
  "the certainty factor of an ANDed list of objects
   (just multiply them)"
  (reduce ‘* (mapcar ‘object-c-factor token)))

(defun implication-strength (val)
  "for a rule to set the implication strength"
  (setq *implication-strength* val))

;;; this function increases the certainty of the object
;;; which is the first argument by an amount dependent
;;; on the combined certainty of the remaining
;;; arguments
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(defun add-evidence (obj &rest token)
  "increments the certainty of obj based on the
   certainty of token"
  (let ((c-f (slot-value obj ‘c-factor)))
    (setf (slot-value obj ‘c-factor)
          (+ c-f
             (* (- 1 c-f) *implication-strength*
                (token-c-factor token))))))

;;; this tactic is dynamic as the certainty factor slot
;;; gets changed by calling add-evidence

(deftactic certainty :dynamic (i1 i2)
  "a conflict resolution tactic to prefer more certain
   instantiations"
  (> (inst-c-factor i1) (inst-c-factor i2)))

;;; Before firing a rule this meta-interpreter just
;;; sets the value of *c-factor* to the certainty of
;;; the instantiation so that any new uncertain objects
;;; made get this (times *implication-strength*) as
;;; their certainty. Also sets *implication-strength*
;;; to 1 as a default in case the rule doesn’t set it.

(defrule uncertain-context :backward
  ((uncertain-context)
   <--
   (start-cycle)
   (instantiation ?inst)
   ((progn (setq *c-factor* (inst-c-factor ?inst))
      (setq *implication-strength* 1)))
   (fire-rule ?inst)
   (cut)
   (uncertain-context)))

Below are some example rules using this facility for a simple car maintenance
problem.

;;; ---------------- SOME EXAMPLE RULES ---------------
;;; to run: (run-diagnose)

(def-kb-struct start)
(def-kb-class symptom (uncertain-kb-object)
  ((type :initarg :type)))
(def-kb-class fault (uncertain-kb-object)
  ((type :initarg :type)))
(def-kb-class remedy (uncertain-kb-object)
  ((type :initarg :type)))
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;;; this context sets up the initial hypotheses and
;;; gathers evidence this doesn’t need the meta
;;; -interpreter as that’s only necesssary for
;;; transparent assignment of certainty factors to new
;;; objects

(defcontext diagnose :strategy ())

(defrule start-rule :forward
  :context diagnose
  (start ?s)
  -->
  (assert (symptom ? type over-heat c-factor 1))
  (assert (symptom ? type power-loss c-factor 1))
  (assert (fault ? type lack-of-oil c-factor 0.5))
  (assert (fault ? type lack-of-water c-factor 0))
  (assert (fault ? type battery c-factor 0))
  (assert (fault ? type unknown c-factor 0))
  (context (cure)))
               ; next context onto agenda

(defrule diagnose1 :forward
  :context diagnose
  (symptom ?s type over-heat)
  (fault ?f type lack-of-water)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))

(defrule diagnose2 :forward
  :context diagnose
  (symptom ?s type overheat)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

(defrule diagnose3 :forward
  :context diagnose
  (symptom ?s type wont-start)
  (fault ?f type battery)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))
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(defrule diagnose4 :forward
  :context diagnose
  (symptom ?s type wont-start)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

(defrule diagnose5 :forward
  :context diagnose
  (symptom ?s type power-loss)
  (fault ?f type lack-of-oil)
  -->
  ((implication-strength 0.9))
  ((add-evidence ?f ?s)))

(defrule diagnose6 :forward
  :context diagnose
  (symptom ?s type power-loss)
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  ((add-evidence ?f ?s)))

;;; any two distinct symptoms strengthens the
;;; hypothesis that there’s something more serious
;;; going wrong

(defrule diagnose7 :forward
  :context diagnose
  (symptom ?s1 type ?t1)
  (symptom ?s2 type ?t2)
  (test (not (eq ?t1 ?t2)))
  (fault ?f type unknown)
  -->
  ((add-evidence ?f ?s1 ?s2)))

;;; here we need the meta-interpreter to assign the
;;; right certainty factors to the remedy objects. Also
;;; use certainty as a conflict resolution tactic to
;;; print the suggested remedies out in order

(defcontext cure :strategy (priority certainty)
                :meta ((uncertain-context)))
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(defrule cure1 :forward
  :context cure
  (fault ?f type unknown)
  -->
  ((implication-strength 0.1))
  (assert (remedy ? type cross-fingers))
  ((implication-strength 0.9))
  (assert (remedy ? type go-to-garage)))

(defrule cure2 :forward
  :context cure
  (fault ?f type lack-of-oil)
  -->
  (assert (remedy ? type add-oil)))

(defrule cure3 :forward
  :context cure
  (fault ?f type lack-of-water)
  -->
  (assert (remedy ? type add-water)))

(defrule cure4 :forward
  :context cure
  (fault ?f type battery)
  -->
  (assert (remedy ? type new-battery)))

(defrule print-cures :forward
  :context cure
  :priority 5
  (remedy ?r type ?t)
  -->
  ((format t "~%Suggest remedy ~a with certainty-factor
             ~a" ?t (slot-value ?r ‘c-factor))))

(defun run-diagnose ()
  (reset)
  (make-instance ‘start)
  (infer :contexts ‘(diagnose)))

B.4  Other Examples
Other examples distributed with KnowledgeWorks include:

• Truck — a largely forward chaining truck scheduling example,

• Spill — an outline of a chemical spillage diagnosis system, and
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• Whist — a windowing example which plays whist.
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CImplementation Notes
C.1  Forward Chainer

C.1.1  Forward Chaining Algorithm

The KnowledgeWorks forward chaining engine is based on the RETE algo-
rithm (see Rete: A Fast Algorithm for the Many Pattern/Many Object Pattern
Match Problem by Forgy in Artificial Intelligence 19, September 1982). A data
flow network representing the conditions of the forward chaining rules (a
RETE network) is maintained and this keeps lists of the instantiations and
partial instantiations of rules. This structure is modified at runtime as objects
change. The RETE algorithm relies on the tacit assumption that during the for-
ward chaining cycle relatively few objects change (hence there are relatively
few changes to be made to the network each cycle), and in these cases gives a
huge increase in performance speed.

C.1.2  CLOS and the Forward Chainer

CLOS objects acquire KnowledgeWorks functionality from the STANDARD-KB-

OBJECT mixin. Object creation and modification hooks defined on this mixin
enable the RETE network to track the objects. Objects are indexed into the
RETE network by class and modifications propagated only where any
changes to the slots of the object are relevant.
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One potential problem is that as KnowledgeWorks CLOS objects are designed
for use in ordinary code, performance could deteriorate seriously as every
time an object is changed the RETE network must be amended. For this reason
changes to CLOS objects are merely remembered as they are made. The stored
set of changes is flushed at the start of every forward chaining cycle, so the
penalty for using KnowledgeWorks objects is really only paid when the for-
ward chainer is running.

C.1.3  Forward Chaining and the Backward Chainer

For more uniform semantics throughout KnowledgeWorks, the right hand
side of KnowledgeWorks forward chaining rules are executed directly by the
backward chainer, as is the default meta-interpreter for a context which has no
meta-interpreter specially defined. When compiled with debugging turned
off, in many cases the backward chainer can be optimised out leaving raw
Lisp code.

C.2  Backward Chainer

C.2.1  Backward Chaining Algorithm

The KnowledgeWorks backward chaining system is an extended Prolog writ-
ten entirely in Lisp and based loosely on the Warren Abstract Machine
(WAM). (see An Abstract Prolog Instruction Set by David H.D. Warren, Techni-
cal Note 309 SRI International October 1983). High performance is achieved
by compiling each Prolog clause into a Lisp function and handling the Prolog
control flow with continuation passing. This approach removes the need for
interpretation and provides easy integration with CLOS.

C.2.2  Term Structure

In order to provide compatibility with Edinburgh Prolog, the Knowledge-
Works backward chaining system treats Prolog structured terms differently
from lists. Structured terms whose functors are not ‘.’ are stored as simple vec-
tors with the functor as element 0 (for example, the term: foo(bar)  is equiva-
lent to #(foo bar) ).



C.2 Backward Chainer
C.2.3  The Binding Trail

The variable binding trail for the backward chainer is stored in a simple vector
but may overflow into list structure if the trail grows larger than the size of the
vector: (30000). The system will continue to function normally when this hap-
pens but may slow down slightly and do more consing. (Note: We have never
written a program that causes this to happen other than deliberately produced
testing programs).
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Appendix D

DConverting Other Systems
D.1  OPS5
OPS5 rulebases may be readily converted into KnowledgeWorks rulebases.
The main OPS5 forms needing conversion are:

• literalize  into def-kb-struct  or def-kb-class . For example

(literalize employee name father-name mother-name)

could become

(def-kb-struct employee name father-name mother-name)

• strategy  into a defcontext form with the right conflict resolution strat-
egy. For example

(strategy lex)

could become

(defcontext ops5 :strategy (lex specificity))

and

(strategy mea)

could become
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(defcontext ops5 :strategy (mea lex specificity))

In OPS5 you cannot have different conflict resolution strategies for different
sets of rules. The KnowledgeWorks context mechanism for passing control is
much clearer and more powerful than, for instance, the use of the MEA strat-
egy as sole control mechanism in OPS5.

• p into defrule . For example, the OPS5 rule

(p recognize-pair
  (employee ^name <parent>)
  (employee ^name <child> ^mother-name <parent>)
  -->
  (make pair))

will become

(defrule recognize-pair :forward
  (employee ? name ?parent)
  (employee ? name ?child mother-name ?parent)
  -->
  (assert (pair ?)))

As an extended example below are given some OPS5 rules from the Monkey
and Banana problem (see Appendix B, “Examples”):

(strategy mea)
(literalize monkey
  name at on holds)
(literalize object
  name at weight on)
(literalize goal
  status type object to)
(literalize start)

(p mb1
  (goal ^status active ^type holds ^object <w>)
  (object ^name <w> ^at <p> ^on ceiling)
  -->
  (make goal ^status active ^type move ^object ladder
        ^to <p>))



D.1 OPS5
(p mb4
  {(goal ^status active ^type holds ^object <w>) <goal>}
  (object ^name <w> ^at <p> ^on ceiling)
  (object ^name ladder ^at <p>)
  {(monkey ^on ladder ^holds nil) <monkey>}
  -->
  (write (crlf) Grab <w>)
  (modify <goal> ^status satisfied)
  (modify <monkey> ^holds <w>))

(p mb8
  (goal ^status active ^type move ^object <o> ^to <p>)
  (object ^name <o> ^weight light ^at <> <p>)
  -->
  (make goal ^status active ^type holds ^object <o>))

In KnowledgeWorks this could be:

(defcontext ops5 :strategy (mea lex specificity))

(def-named-kb-class monkey ()
  ((at :initform nil)
   (on :initform nil)
   (holds :initform nil)))

(def-named-kb-class object ()
  ((at :initform nil)
   (weight :initform nil)
   (on :initform nil)))

(def-kb-struct goal status type object to)
(def-kb-struct start)

(defrule mb1 :forward
  :context ops5
  (goal ? status active type holds object ?w)
  (object ? name ?w at ?p on ceiling)
  -->
  (assert (goal ? status active type move object ladder
                  to ?p)))
163



Appendix D Converting Other Systems

164
(defrule mb4 :forward
  :context ops5
  (goal ?g status active type holds object ?w)
  (object ? name ?w at ?p on ceiling)
  (object ? name ladder at ?p)
  (monkey ?m on ladder holds nil)
  -->
  ((format t "~%Grab ~S" ?w))
  (assert (goal ?g status satisfied))
  (assert (monkey ?m holds ?w)))

(defrule mb8 :forward
  :context ops5
  (goal ? status active type move object ?o to ?p)
  (object ? name ?o weight light at ?q)
  (test (not (eq ?q ?p)))
  -->
  (assert (goal ? status active type holds object ?o)))

D.2  Prolog
Please refer to Appendix A.9, “Edinburgh Syntax”.



Appendix E

EFor More Information
E.1  General References

E.1.1  Forward Chaining

• Programming Expert Systems in OPS5, An Introduction to Rule-Based Pro-
gramming by Lee Brownston, Robert Farrell, Elaine Kant and Nancy
Martin (Addison-Wesley). Whilst being specifically on OPS5 this text
covers most aspects of forward chaining in considerable detail.

E.1.2  Backward Chaining and Prolog

• The Art of Prolog, by Leon Sterling and Ehud Shapiro (MIT Press).

• The Craft of Prolog, by Richard A. O’Keefe (MIT Press). This is a more
advanced text.

E.1.3  Uncertain Reasoning

• Rule-Based Expert Systems, by B. G. Buchanan and E. H. Shortliffe (Addi-
son-Wesley). This text covers specifically the MYCIN system.
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E.1.4  Expert Systems

• Building Expert Systems, by Frederick Hayes-Roth, Donald A. Waterman
and Douglas B. Lenat (Addison-Wesley). This text focuses more on the
issues involved in designing an expert system.

E.1.5  Lisp and CLOS

• Common LISPcraft, by Robert Wilensky (Norton). An introductory text
on Lisp.

• Common Lisp the Language, Second Edition, by Guy. L. Steele Jr. (Digital
Press). This is the complete reference book on Common Lisp.

• Object-Oriented Programming in Common Lisp, by Sonya E. Keene (Addi-
son-Wesley). An introductory text on CLOS for programmers.

• The Art of the Metaobject Protocol, by Gregor Kiczales, Jim des Rivieres
and Daniel G. Bobrow (MIT Press). This is the only proper guide to the
CLOS Metaobject Protocol.

E.2  The LispWorks manuals
The LispWorks manual set comprises the following books:

• The LispWorks User Guide describes the features and tools available in
LispWorks.

• The LispWorks Reference Manual contains detailed information on all
functions, macros, variables and classes available in LispWorks, in
alphabetical order.

• The Common LispWorks User Guide describes Common LispWorks, the
user interface for LispWorks. Common LispWorks is a set of windowing
tools that let you develop and test Common Lisp code more easily and
quickly.

• The LispWorks Editor User Guide describes the keyboard commands and
programming interface to the Common LispWorks editor tool.

• The LispWorks CAPI User Guide and the LispWorks CAPI Reference
Manual describe the CAPI. This is a library of classes, functions, and



macros for developing graphical user interfaces for your applications.
The LispWorks CAPI User Guide is a tutorial guide to the CAPI, and the
LispWorks CAPI Reference Manual is an in-depth reference text.

• The LispWorks Foreign Language Interface User Guide and Reference Man-
ual explains how you can use C source code in applications developed
using LispWorks.

• The LispWorks Delivery User Guide describes how you can deliver work-
ing, standalone versions of your LispWorks applications for distribution
to your customers.

• The LispWorks KnowledgeWorks and Prolog User Guide—this book—
describes the LispWorks toolkit for building knowledge-based systems.
Prolog is a logic programming system within Common Lisp.

• The CommonLisp Interface Manager 2.0 User’s Guide describes the porta-
ble Lisp-based GUI toolkit.

• A set of installation notes explain how to install LispWorks and start it
running, also containing a set of release notes is provided that docu-
ments last minute issues that could not be included in the main manual
set.

These books are all available in online form, in both HTML format and PDF
format.

Commands in the Help  menu of any of the Common LispWorks tools
give you direct access to the online documentation in HTML format,
using the HTML browser that is supplied with LispWorks. Details of
how to use these commands can be found in the Common LispWorks User
Guide.

Documentation is also provided in PDF form. You can use Adobe Acro-
bat Reader to browse the PDF documentation online or to print it.
Adobe Acrobat Reader is available for free download from Adobe’s web
site, http://www.adobe.com/ .

Please let us know if you find any mistakes in the LispWorks documentation,
or if you have any suggestions for improvements.
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Glossary
agenda

A stack of rule groups (or contexts). Control can be passed to the next
context on the agenda.

arity

The number of arguments (to a function, rule condition etc.)

backward chaining

The process of reasoning backward from postulated goals to determine
if their preconditions can be satisfied. If these preconditions are satisfied
the postulated goals are considered true.

browsers

Windows which allow the user to look freely through different parts of
the system.

class

In object-oriented programming, classes define classes with the same
attributes (slots) and behaviour (methods). Instances of these classes are
created during the execution of a program which represent concrete
examples of the abstract class descriptions.
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conflict resolution strategy

The method(s) used to decide which of a set of eligible rules will fire. A
conflict resolution strategy is a list of conflict resolution tactics which are
applied in sequence to the conflict set to determine which instantiation
is to fire.

conflict resolution tactic

A single predicate used to decide whether one instantiation is to be pre-
ferred to another. They may be combined into a conflict resolution strat-
egy.

conflict set

The set of instantiations of rules which at a given time are matched by
the object base.

contexts

Groups of rules in a knowledge base.

destructuring

The ability to match an expression against a piece of data where vari-
ables in the expression are bound to the corresponding parts of the data
if the structure of the expression and the data agree. For example, (?x .
?y) can match (1 2 3) with ?x binding to 1 and ?y to (2 3).

forward chaining

The process of reasoning forward from known facts to perform arbitrary
actions and to deduce new facts.

forward chaining cycle

The process of matching the conditions of rules against the object base to
produce a set of rules eligible to fire (the conflict set), selecting one of
those (conflict resolution) and firing it (performing its actions).

inference engine

The part of the system which is responsible for rule-firing, either in back-
ward or forward chaining mode.



instantiation

An instantiation of a rule is the set of objects against which a rule
matches. A rule may have no instantiations (if it is not matched at all by
the object base) or many instantiations (each referring to a different set of
objects).

knowledge based systems

A system which encodes the knowledge for a problem domain in high-
level forms, usually facts and rules. The software architecture separates
the knowledge from the inference mechanism used to deduce new
knowledge.

LispWorks

An advanced Common Lisp programming environment, which serves
as the infrastructure for KnowledgeWorks.

meta object protocol (MOP)

Describes how the Common Lisp Object System is implemented in
terms of itself. Hence CLOS may be used to modify its own behaviour.

meta rule protocol (MRP)

Allows the user to debug, modify or replace the default behaviour of
forward chaining rules in the system in terms of backward chaining
goals.

object base

The set of CLOS objects which KnowledgeWorks can reason over
(“knows about”).

object-oriented

Programming paradigm in which structures within the language are
organised as classes of objects which have attributes (slots) and behav-
iour (methods) associated with them.
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objects

The KnowledgeWorks™ object base contains KnowledgeWorks CLOS
objects, which may for efficiency be replaced by KnowledgeWorks struc-
tures.

structures

A CLOS class can be replaced by a structure class in cases where speed is
important and the code must be optimised, and when the full power of
CLOS is not required. The structure is then analogous to the CLOS
object.

toolkit

A collection of complementary software or utilities (such as Knowledge-
Works™) with a common application focus.
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